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FOREWORD

The CAMEO Companion is designed to provide a written help resource
for all CAMEO Suite users, particularly those who utilize the software on
an occasional basis. The Companion developers recognize that while
many persons attend CAMEO training courses, the skills gained in those
training sessions fade when persons operate the programs infrequently.
The CAMEO Companion provides explanations and step-by-step
instructions to help CAMEO users perform emergency response and
planning activities learned in CAMEO training classes.

It is an integrated resource, compiling information and assistance for
the four CAMEO components. It is not intended, nor does it claim, to be
comprehensive; the Companion provides refresher-type information for
CAMEO functions commonly used in emergency response and planning
activities. More detailed explanations regarding the CAMEO products
are found in the User Manuals produced by EPA/NOAA which are freely
available on the CAMEO website.

The CAMEO Companion features 2 main sections: CAMEO Companion
for Responders and CAMEO Companion for Planners. The text allows
publication of 1 book containing both sections, or each section may be
published as a stand-alone product. The decision as to how best to
publish the Companion is left to the discretion of those providing this
resource to their constituents.

The developers welcome all comments, criticisms, corrections, and
suggestions related to this work.

Questions or comments related to Companion content may be
addressed to:

Tom Bergman
443 N.W. 46th Terrace, Oklahoma City, OK  73118
405-528-5518, tom.bergman@sbcglobal.net

Questions regarding publication of the materials may be addressed to:

Daniel Roe
Executive Director
Arizona Emergency Response Commission
5636 East McDowell Road, Phoenix, AZ 85008
602-231-6345, Dan.Roe@azdema.gov
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CAMEOfm Companion for RespondersCAMEOfm Companion for RespondersCAMEOfm Companion for RespondersCAMEOfm Companion for RespondersCAMEOfm Companion for Responders
GET THE SOFTWARE

M From the Internet: CAMEOfm, ALOHA, MARPLOT, RMP-
COMP, NOAA Evaporation Calculator, Tier 2 Submit

M From other users: Copy the installers programs to CD-
ROM; use export and import functions to move
appropriate data

WEBSITES

M CAMEOfm and ALOHA: http://www.epa.gov/ceppo/
cameo

M Tier 2 Submit: http://yosemite1.epa.gov/oswer/
ceppoweb.nsf/content/tier2.htm#t2forms

M RMP-COMP: http://yosemite1.epa.gov/oswer/
ceppoweb.nsf/content/rmp-comp.htm

M Landview 5 and  6: http://www.census.gov/geo/
landview/; http://www.atlas.lsu.edu/landview5/

THE INSTALLER PROGRAMS

By visiting the websites, you generally download the “installer”
programs. The following instructions suggest you “save” the various
installer utilities to your computer desktop. However, you may choose
to “save” them to a CD-ROM as well. In either case, the process remains
the same.

1. Download the “installer”

2. Open to installer to write the software to your computer

After you download the “installer” programs, you will “double-click” on
each and be able to load each respective program on your computer,
usually to your c:/ drive.

Many of you will be using Landview along with the CAMEOfm suite. If
you are using Landview, do not download MARPLOT from the
CAMEOfm homepage!
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DOWNLOADING THE INSTALLERS

CAMEOfm and ALOHA

1. Go to www.epa.gov/ceppo/cameo

2. Choose “Request CAMEOfm” or “Request ALOHA” from the left
side of your screen

3. Scroll down to # 2 and select “CAMEOfm Download Page”

4. Choose either of the following options:

a. CAMEOInstaller.exe (windows)

b. CAMEOInstaller.hqx (macintosh)

5. Choose “Save this file to disk”

6. Save it to your desktop or CD-ROM

MARPLOT

With Landview 5:

1. If you are using Landview 5, MARPLOT installs with Landview
(see “Installing Landview below). In this case, do not install
MARPLOT from the CAMEOfm Homepage!

Without Landview 5:

1. Go to www.epa.gov/ceppo/cameo

2. Choose “Request CAMEOfm” from the left side of your screen

3. Scroll down to # 3 and select “MARPLOT Download Page”

4. Choose either “MARPLOT for Windows” or “MARPLOT for the
MacIntosh”

5. Choose “Save this file to disk”

6. Save it to your desktop or CD-ROM

RMP-COMP

1. Go to web address: http://yosemite1.epa.gov/oswer/
ceppoweb.nsf/content/rmp-comp.htm

2. Scroll down to “Get RMP-COMP” and select it

3. Select “Download RMP-COMP”

4. Save to your desktop or CD-ROM
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Landview
At the time of this writing, Landview 6 is available, but cannot yet by
downloaded from the Internet. Information about “ordering” Landview
from the U.S. Census Bureau can be found at: http://www.census.gov/
geo/landview/

Landview is a “public domain” software, which means anyone may copy
and use the product. You may to obtain “free” copies of Landview from
one of your state agencies, or from your regional EPA offices. Landview
5 is available for free download at: http://www.atlas.lsu.edu/landview5/

Installing Landview
Landview installs its own operating software, and also installs MARPLOT.
Installing Landview will depend on the “version” you acquire. You may
have a “run-time” version, which will open and run simply by inserting
the CD into your computer CD tray. The difference between “run-time”
and “regular” versions of Landview are made readily apparent by simply
placing the Landview CD in the computer tray and “opening” the
program. The runtime version will display as follows on your computer
screen. Either version may be installed using the following steps.

1. Insert the Landview CD-ROM into your CD tray

2. Allow a minute or so for the computer to read the Landview CD

3. If the Landview “splash screen” appears, close it

4. Use your desktop or start menu to open the My Computer folder

5. Select the drive labeled “lv5”

6. Select the INSTALL folder

7. Select the “mac” or “windows” folder as appropriate to your
computer

8. For windows, select INSTALL.EXE

9. For mac, extract the LandView_5_Installer.hqx and follow the
directions (see Instructions on CAMEOfm Homepage)

Most of the time, you will want to install the CAMEOfm suite programs
to your c: drive. If you need to install to other drives, you will need to
make some adjustments in the pathways that allow CAMEOfm, ALOHA,
and MARPLOT to communicate.

OPERATING CAMEOFM ON A NETWORK

See CAMEOfm Help: Managing Your CAMEOfm System: Running
CAMEOfm on a Network.
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Using the “Navigator”Using the “Navigator”Using the “Navigator”Using the “Navigator”Using the “Navigator”
CAMEOfm offers several ways to navigate in a specific module or
between modules. Some navigation tools are native to FileMaker Pro and
the NOAA programming staff has built others. How you choose to move
about in the software is completely up to you.

The CAMEOfm initial screen (also known as a “splash screen”) is called
“the navigator”. From this screen, you can choose from three basic
actions:

M Initiate a search in either the Chemical
Library or the Facilities module

M Move from module to module within
CAMEOfm

M Move to ALOHA or MARPLOT

To return to the navigator screen:

1. Choose “Navigator” from a
module toolbar

2. Select “File”, then “Show Navigator”
from the CAMEOfm main toolbar

Two FileMaker Pro navigation techniques also allow
a return to “the navigator”. These two techniques are:

M Select “Windows” then “Navigator” from the CAMEOfm main
toolbar

M Finding the navigator module box as part of the “minimized”
module boxes residing at the bottom of your screen
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Finding a Chemical Record in theFinding a Chemical Record in theFinding a Chemical Record in theFinding a Chemical Record in theFinding a Chemical Record in the
CAMEOfm Chemical LibraryCAMEOfm Chemical LibraryCAMEOfm Chemical LibraryCAMEOfm Chemical LibraryCAMEOfm Chemical Library

OPENING THE BASIC SEARCH ENGINE FROM THE NAVIGATOR

1. Open the Navigator Screen

2. Select “Search for a
Chemical”

OPENING THE BASIC SEARCH

ENGINE FROM THE SEARCH

MENU

1. Open the Chemical Library

2. Select the “Search” menu, then
select “Start Search”*

FINDING A CHEMICAL RECORD USING BASIC SEARCH

Search Screen “Operators”
Make sure to set the “search operator” to the desired selection, which
will be either “Contains word” or “Contains word starting with”. Both
operators work for either “text” or “numeric” fields.

Basic Search Tips

Chemical Name: A Chemical Name search may return any number of
“found” chemical names, because the Search examines both the
“preferred chemical name” and the “synonyms”.  There are 6113
“preferred chemical names” and over 80,000 “synonyms” in CAMEOfm
(see What to Do When Your Search Returns Multiple Chemical Names).

CAS #: CAS # format is as follows:  reading the number string from right
to left, there will be 1 digit, - , 2 digits, - , then from 2-6 digits. Example
CAS Numbers:  64-69-1; 8002-05-9; 101-98-3; 10004-55-7.  You must
enter the CAS # with the “dashes” in the correct placement.

*Note: Do NOT    use the “ENTER” key on your key
board at any time during the  search process.

○

○

○
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DOT Label:  The DOT Label is not the same as the transportation
placard number (UN/NA #).  DOT Label choices are given in the drop-
down menu.

CHRIS Code:  Three- letter code usually found on ocean-going
shipments.

UN/NA #:  UN/NA stands for “United Nations/North American”.  This is
the familiar four-digit transport
placard found on trucks, railcars,
etc.

General Description: This search
the RIDS General Description field,
which is a “text” field.  It is usually
best to enter only one “text” term
at a time, and then use either the
Subset Search/Append Search to “add” other text words to be
searched.*

Advanced Search Tips

Opening Advanced Search:  Advanced Search is always opened from
the Basic Search screen.

Advanced Search “AND /OR” Options:  Make sure to select “AND” or
“OR” search options as appropriate for the specific search.

Resetting the Advanced Search:  Advanced Search allows up to four
fields per search.  To “reset” from multiple fields to a single field, use
the “Remove a Choice” button until only a single field and operator line
is displayed.  Use “Clear All Fields” to delete previous search
parameters.

Searching RIDS Properties:  You may search the CAMEOfm “Properties”
values; including IDLH, Vapor Pressure, LEL, UEL, ERPG, Flash Point,
Specific Gravity, etc.  Properties searches allow numeric value input
ONLY.  You may not determine the “units” associated with a particular
field.  For example, IDLH values may be expressed as “ppm” or “mg/m3”;
a “found set” for “IDLH is less than 500” will include chemical records
with both IDLH less than 500 “ppm”, and IDLH less than 500 “mg/m3”.
Most Properties fields have the same “units” throughout the database
(e.g., UEL/LEL are always expressed as %) or may be unitless (e.g.,
specific gravity has no “units”).

*Note:  For best results, use “general”
text search terms. For example, when
searching for a “white crystal”, split the
terms into two searches: one search for
the word “white”, then a subset search
for the word “crystal”.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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What TWhat TWhat TWhat TWhat To Do When Yo Do When Yo Do When Yo Do When Yo Do When Your “Search” Returnsour “Search” Returnsour “Search” Returnsour “Search” Returnsour “Search” Returns
Multiple Chemical NamesMultiple Chemical NamesMultiple Chemical NamesMultiple Chemical NamesMultiple Chemical Names

EXPLANATION OF CAMEOFM “CHEMICAL NAME” SEARCH

Chemical Name List and Synonyms
A Chemical Name search may return any number of “found” chemical
names, because the search examines both the “preferred chemical
name” and the “synonyms”.  There are 6113 “preferred chemical names”
and over 80,000 “synonyms” in CAMEOfm.

One way to “narrow” your search is to use the “Subset Search” to enter
additional search information.

Example: Searching for “chlorine”:

1. Open the Chemical Library Basic Search

2. Set Search Operator to “contains a word starting with”

3. Enter “Chlorine” to Chemical Name field

4. Select “Search” and view the 28 found set

5. Select the “Search” menu

6. Select “Subset Search”

7. Enter “7782” in the CAS # field

8. Select “Search”; the found set is now single chlorine record.
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Understanding the Chemical LibraryUnderstanding the Chemical LibraryUnderstanding the Chemical LibraryUnderstanding the Chemical LibraryUnderstanding the Chemical Library
InformationInformationInformationInformationInformation

DEFINING FIELD DATA AND ACRONYMS

Definitions for the Chemical Library Fields and most of the RIDS
Acronyms can be found in the CAMEOfm Glossary and Help sections.

Definitions of Chemical Library Data Fields
1. Select the “Help” menu from the CAMEOfm top menu bar. This

should open the Contents page.

2. Scroll down to Heading 3, “Working with Chemical Records”

3. Select “Understanding the information in the Chemical Library”

Here you can find all the
definitions for the Chemical
Library ID and RIDS sections
fields.

Definitions of Acronyms
Definitions of acronyms and
other chemical terminology
are found in the CAMEOfm
Help Glossary.

1. Select the “Help” menu from the
CAMEOfm top menu bar. This should open the Contents page

2. Scroll down to the bottom of the page and select “Glossary”

3. Use the scroll bar or the index letters to locate the term of
interest
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Researching Chemical InformationResearching Chemical InformationResearching Chemical InformationResearching Chemical InformationResearching Chemical Information
ASSESSING RISKS FOR A SPECIFIC CHEMICAL

Determining the dangers associated with each chemical can be a
complex process.  In association with the CAMEOfm Chemical Library,
you should utilize any and all other available sources of chemical
information, including MSDS sheets, the Emergency Response
Guidebook, the NIOSH Chemical Handbook, and other software
programs.

One way to use the CAMEOfm Chemical Library is to attempt to answer
the following questions by viewing the associated Chemical Library ID
and RIDS tabs.

Can this material hurt me?

M NFPA Codes

M Regulatory Page (see CAMEOfm Glossary and Help)

M General Description

M Properties

How can this material hurt me (i.e., inhalation, ingestion,
absorption, explosion, reactivity)?

M General Description

M Properties

M Health Hazards

M Reactive Hazards

M Fire Hazards
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What level of exposure does it take to hurt me?

M Properties: ERPG, AEGL, TEEL, IDLH, and TLV values

M Health Effects

What can I do for victims?  First-Aid and other Medical
information

M First Aid

M Health Effects

What step can I take to control the release? Response Options
and Personal Protection Information

M Non-Fire Response

M Firefighting

M General Description

M Protective Clothing



cameofm ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

32

CAMEOFM AND REACTIVE CHEMICALS

Chemical ID and RIDS Sections
CAMEOfm features six sources of information concerning Chemical
Reactivity, which can all be found in the Chemical Library. These six
sources are:

1. Chemical ID Section

a. NFPA Reactive Rating

b. NFPA Special Rating

2. RIDS Section

a. General Description

b. Reactivity

c. Reactive Hazards

3. Reactivity Worksheet (when two or more substances are
involved)

a. Reactivity Worksheet (under “Record” menu)

Reactive information for each of the 6113 chemical entries may NOT be
available. You should examine all five single substance Chemical Library
sources when investigating the hazards associated with a specific
substance.

NFPA Reactive Ratings
A definition of the NFPA ratings is available in the CAMEOfm Help
Section, “Understanding the information in the Chemical Library”. In the
CAMEOfm Chemical Library, 68 substances carry an NFPA Reactive
Rating of “3” or “4”.

“No Water” is the NFPA “Special” designation for water reactive
substances. In the CAMEOfm Chemical Library, 37 substances are so
designated.

RIDS Section
The General Description for a substance may list reactivity as a hazard.

The RIDS Reactive Hazards categorizes substances by nine different
reactive types. There are 2,437 substances that feature some type of
Reactive Hazards information.
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The RIDS Reactivity tab organizes chemicals into three headings
regarding their reactive potential. The headings are:

M Air and Water Reactions

M Chemical Profile

M Reactive Groups

All 6113 substances in the
CAMEOfm Chemical Library
contain some data in the
Reactivity tab, although some
of those entries list the substance as
“non-reactive”.

CAMEOfm Reactivity Worksheet
The CAMEOfm Reactivity Worksheet should be used when two or more
substances are involved. This worksheet “predicts” potential outcomes
of two substances interacting. While you may enter any number of
substances to the Reactivity Worksheet, the result are ALWAYS “paired”.
This means that the worksheet provides predictions for mixing only two
chemicals at a time.

To use the Reactivity Worksheet:

1. Select an entry from the CAMEOfm Chemical Library

2. Select the “Record” menu

3. Select “Add to Reactivity Worksheet”

A text box will appear asking if you would like to view the Reactivity
Worksheet. You may select “Yes” or “Later” depending on whether you
are finished selecting information to add to the Reactivity Worksheet.

After you are finished adding chemicals to the Worksheet:

1. Select the “Record” menu

2. Select “View the Reactivity Worksheet”

The predicted potential outcomes are now listed on your screen. You
may print a copy using the “Make Report” function.



cameofm ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

34

RESEARCHING CAMEOFM FIXED-FACILITY INFORMATION*

Finding the Facility Record
The Facility Record of interest should be found in the “Facilities”
module.

1. Activate CAMEOfm and select the “Facilities” module icon and
scroll up or down to locate the record of interest (depending on
the number of records in your CAMEOfm database, you may
wish to “find” the facility using the CAMEOfm Search function).

2. Select the “Search” menu, then select “Start Search”

3. Enter the facility name in the appropriate text field and select
“Search”

Where is the facility located?
1. Highlight the facility record

2. Select the “Record” button or double-click the line entry

3. Select the “Address” tab

Who can I call and what are their phone numbers?
CAMEOfm stores phone numbers in two places, depending entirely on
how the data was entered.

1. Open the Facilities Module (if you have opened a different
CAMEOfm module, select the “Navigator” button, then select the
“Facilities” tab)

2. Open the Facility Record and select the “Phones” tab. View
information, if empty

3. Select “Contacts” tab, then select the name of interest from the
list and double-click

4. Select the “Phones” tab

*Note: This section of the CAMEOfm Companion for Responders book
is usable ONLY IF local Tier 2 report information has been entered into
your CAMEOfm.

○ ○ ○ ○ ○ ○
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Where is the release occurring at the facility?*

1. Open the Facilities Module (if you have opened a different
CAMEOfm module, select the “Navigator” button, then select the
“Facilities” tab)

2. Open the Facility Record

3. Select “Chemicals in Inventory” tab and double-click the
chemical of interest from the list

4. Click the “Location” tab*

How much of this substance could be at this facility?

M Click the “Physical State and Quantity” tab*

Chemical in Inventory “Components” Tab
Many times, facilities report “mixtures” and/or “solutions” of chemicals.
Information concerning those chemical mixtures may be found in the
Components tab. You should always view the Components tab to
determine if any additional information is available there.

*Note: To “interpret” the “codes” for Type/Press/Temp entries,
use your mouse to “click” on the “title” (click on the word “Type”
or “Press” or “Temp”). A drop-down list of code definitions will
appear.

*Note: To “interpret” the “codes”
for “Max Code” and “Min Code”
entries, use your mouse to Select
the “Edit” button. Then, use your
mouse to “click” on the “code
number”. A drop-down list of
code definitions will appear. To
close without altering the
Chemical record, select the
“Cancel” button.
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*Note: The “Amount” field
found on the “Location” tab
page may show “0”; however,
this does NOT mean the
chemical is not present at this
site. Proceed to “Physical State
and Quantity” tab for
information concerning the
amount of chemical on-site.
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Accessing RIDS Information
1. Select the “View RIDS” button on the right side of your screen

2. Select the “File” menu and select “Close” to return to the
Chemical in Inventory Record after viewing the RIDS information

3. Select the Navigator button then select the “Facilities” module
to return to the Facility record; the screen should open to the
Facility record of interest. If not, use the steps from above to
find and open the correct record.

Viewing Facility Site Plans
1. Open the Facility record of interest and select the “Site Plans”

tab; a list of “linked” site plans for that Facility will appear.
Double-click on the site plan of interest.

Facility “Notes” Tab
Additional information regarding the facility may be available from the
“Notes” tab. You should always view the “Notes” tab to determine if
“extra” information is stored there.
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Printing Reports fromPrinting Reports fromPrinting Reports fromPrinting Reports fromPrinting Reports from
CAMEOfmCAMEOfmCAMEOfmCAMEOfmCAMEOfm
Printing information from any CAMEOfm
module is achieved utilizing the “File/Make
Report” menu.

The “Print” menu functions identically in all
CAMEOfm modules.

1. Select a record or set of records from a module

2. Select the “File” menu

3. Select the “Make Report” function

4. Set the “Make Report” options using the “data to include” boxes

5. Select the “Make Report” button

6. Select “Print”

CAMEOFM PRINT OUTPUT MATRIX

Each CAMEOfm module responds to the “File/Make Report” menu by
offering you a “matrix” of print items. Generally, not all the “matrix
choices” contain data, except in the Chemical Library module.

The Chemical Library operates slightly different from the other
CAMEOfm modules.  Chemical Library print “matrix” allows you to
choose to include:

M “Chemical ID” section

M “RIDS” section

M Both the “Chemical ID” and “RIDS” sections; you accomplish this
by clicking on the “Select Report Type” box

COPYING TO MICROSOFT WORD OR OTHER SOFTWARE

You  may “copy-and-paste” CAMEOfm reports by “highlighting” the
desired text and selecting the Edit/Copy menu, then using the Edit/
Paste menu in Microsoft Word or another software program.
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Finding and Displaying CAMEOfm Facilities,Finding and Displaying CAMEOfm Facilities,Finding and Displaying CAMEOfm Facilities,Finding and Displaying CAMEOfm Facilities,Finding and Displaying CAMEOfm Facilities,
Special Locations, and Resources onSpecial Locations, and Resources onSpecial Locations, and Resources onSpecial Locations, and Resources onSpecial Locations, and Resources on
MARPLOT MapsMARPLOT MapsMARPLOT MapsMARPLOT MapsMARPLOT Maps*****

DISPLAYING A SINGLE CAMEOFM RECORD

1. Open the desired CAMEOfm
module

2. Select the record you wish to
display in MARPLOT

3. Select the “Sharing” menu

4. Select MARPLOT

5. Select “Show On Map”

DISPLAYING A “FOUND SET” OF CAMEOFM RECORDS

1. Open the desired CAMEOfm module

2. Conduct a “search” to identify the records you wish to display

3. Select the “Sharing” menu

4. Select MARPLOT

5. Select “Show All On Map”

*Note: These steps work
ONLY if data have been
entered to CAMEOfm and
linked to MARPLOT objects.
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Acquiring MARPLOT MapsAcquiring MARPLOT MapsAcquiring MARPLOT MapsAcquiring MARPLOT MapsAcquiring MARPLOT Maps

WITH LANDVIEW 5
Usually MARPLOT automatically “reads” Landview maps contained on the
CD-ROM. The Landview CD must be active for this to occur.

1. Insert the Landview CD-ROM or DVD in the disk drive

2. Double-click the Landview icon located on your desktop; this
will open the Landview “splash screen”

3. To start MARPLOT, select the “Go To Map” button. MARPLOT
should now be displayed on your screen

To display “your” county map:

1. Select the “List menu/Map List” menu

2. Type the name of your county into the “Find” box

3. Select “Find Next”; your county map should be highlighted

4. Select “Go To Map”

WITHOUT LANDVIEW 5
If you are operating MARPLOT without
Landview 5, you will need to acquire your
desired maps from the CAMEOfm Website.

1. Open the CAMEOfm Website

2. Select “Updated Census 2000
MARPLOT Maps available for
download.”

3. Select the appropriate state

4. Select the appropriate county

5. Save the “.map” file to your computer*

6. Open MARPLOT and select the “List menu/Map List” menu

7. Select the “Find New Map” button

8. Browse to where the “saved” .map file is located and double-
click

The selected map is added to the MARPLOT Map List. Highlight the map
name and select “Go To Map” to display on your screen.

*Note: You may wish
to create a MARPLOT
maps folder located in
your c: drive. This
folder can store for
many MARPLOT maps.
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Displaying the County Map in MARPLOTDisplaying the County Map in MARPLOTDisplaying the County Map in MARPLOTDisplaying the County Map in MARPLOTDisplaying the County Map in MARPLOT

To open your county map:

1. Activate MARPLOT

2. Select the List menu

3. Select “Map List”

4. Scroll and select your county from the map list

5. Select “Go To Map” button*

WHAT DO I DO IF I CAN’T FIND MY COUNTY MAP IN THE

MARPLOT MAP LIST?
1. First, if your computer usually “reads” the maps from the

Landview CD-ROM, make sure the Landview CD is in the CD
drive tray.

2. If your computer has the maps installed to the hard drive,
reboot your computer. This may or may not resolve the
problem.

If you are using a Landview CD-ROM, the link between MARPLOT and
Landview maps is sometimes dysfunctional. The following steps will
usually restore the link. From the “Map List” box:

1. Select the “Find New Map” button

2. Use the resulting “browse” box to browse to your CD-ROM drive

3. Select the folder listed;  it is usually named “lv5”, but may have
any name

4. Open the “MAPS” folder

5. Open the “tiger” folder

6. Open the state folder

7. Select the appropriate map from the available folders; the maps
are listed alphabetically, but have “numeric” names. You may
need to install several maps to determine which “number” is the
correct choice for your county

8. Open the “NAME.MAP” file; this should return you to the
MARPLOT “Map List” box.

9. Highlight your county map and select “Go To Map”

*Note: Do not select the “OK”
button. The “OK” button
simply returns you to the
previous view.
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LOCATING THE RELEASE SITE IN MARPLOT

Using a CAMEOfm Record to MARPLOT Link (Map Data Tab)
If your CAMEOfm suite has had CAMEOfm records linked to MARPLOT
objects, the following steps will transport you to the desired map point.

To determine if the CAMEOfm record is linked to MARPLOT:

1. Open the desired CAMEOfm record

2. Select the “Map Data” tab

3. See if the “record is linked to MARPLOT” box is checked

If the CAMEOfm to MARPLOT link does exist:

4. Activate the appropriate CAMEOfm Module (Facilities, Special
Locations, Routes, Resources)

5. Select the “Sharing” menu

6. Select “MARPLOT”

7. Select “Show On Map”

Using Lat/Long Coordinates (Go To Lat/Long Function)

1. Activate MARPLOT

2. Select the “View” menu

3. Select “Go To Lat/Long”

4. Enter the coordinate values*

*Note: MARPLOT reads either Deg/
Min/Sec or Digital Degrees format. The
“Go To Lat/Long” box allows you to
select the desired format.
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Using the MARPLOT Search Engine to Search for an Address

To search for a known address:

1. Select the List menu

2. Select “Search”

3. Create a search as shown below (“main” is used only as an
example street name)

4. Select the “Search” button

5. Highlight a road segment from the resulting list
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6. Select the “Addresses” button

7. Highlight the road segment range containing the desired
address;  if no correct segment is displayed, select the “Cancel”
button, then select a different road segment and look for the
desired address range

8. Continue until you find the desired address range

9. Select “Show on Map and Zoom”

The road segment containing the desired address will be “selected” on
you MARPLOT screen.

To examine the particulars of the “selected” road segment:

10. Select the “Objects” menu

11. Select “Segment Settings”

This will display information related to the selected road segment.

To search for a known street intersection:

1. Repeat Steps 1– 5 from page 38

2. Select the “Intersections” button

3. Highlight the desired intersection from the resulting list

4. Select “Show on Map and Zoom”
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Using the Landview Address Finder

To search for a known address plus a known zip code:

1. Activate Landview and go to the Landview Home Screen

2. Select the “Address Finder” button

3. Enter the street name and zip code

4. Select “Find Street”

5. Repeat Steps 6 - 11 from page 39

LOCATING THE RELEASE SITE IN MARPLOT

Using Zoom In/Zoom Out Tools/Hand Tool
1. Select the “Zoom In” tool

2. Move the cursor to the approximate release point on the map

3. Left-click the mouse

4. If needed, adjust your screen with the Hand tool

5. Repeat as needed

Using “Quick Zoom” Function
1. Select the “Zoom In” tool

2. Move the cursor to the approximate release point on the map

3. Left-click and “drag” the mouse; a rectangle area will appear

4. Release the mouse; your screen will resize to the dimensions of
the Quick Zoom area

Using the Set Scale Function
1. Select the pointer tool

2. Move the cursor to the approximate release point on the map
and left-click

3. Select the “View” menu

4. Select “Set Scale”

5. Enter “1” mi; your screen will resize to a one-mile width display
with the selected point in the center.
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MARKING THE RELEASE SITE IN MARPLOT
Here are two methods of “marking” the “release location” in MARPLOT:

Set Focus Point Function
1. Activate MARPLOT

2. Place your cursor on the release point-and-click

3. Select the “View” menu

4. Select “Focus Point”

5. Select “Mark Focus Point”; the marked point will remain as
designated until “cleared” by using the “View/Marked Point”
menu.

The selected point is now the “focus point” which allows use of other
functions found in the  “View/Focus Point” menu.

Opening a New Layer
1. Activate MARPLOT

2. Select the List menu

3. Select “Layer List”

4. Select the “New” button

5. Enter a new layer name (duplicate layer names are not allowed)

6. Set to the “User’s Map” selection

7. Select “OK”

8. Use the draw tools to “mark” the release site
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CUSTOMIZING THE MARPLOT MAP DISPLAY

Saving and Setting Views

View Menu Overview
The “View” menu allows you to save screenshots. After a screenshot is
saved, it can be accessed via the “Go To View” function and may be “set”
as an Entry View or a Reference View.

Save Current View

1. Select the “View” menu

2. Select “Save Current View”

3. Name the view (duplicate names are not allowed)

4. Set to the “User’s Map” selection

5. Select “OK”

Go To View

M Displays the saved view

Set Entry View

M Displays saved view whenever MARPLOT is activated

Set Reference View

M Sets selected view as the “picture in a picture” box

After a “view” is “saved”, you may access the three functions listed
above. All are found in the “View” menu.
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SELECTING WHICH “LAYERS” ARE DISPLAYED

Resetting the Layer List (Restore the Basic Map Display)

With Landview 5 active:

1. Open the List menu

2. Select “Layer List”

3. Select the “Global Hide” button (immediately below the “Hide”
header text)

4. Select “Set to Default Settings” button

If Landview 5 is not active:

1. Open the List menu

2. Select “Layer List”

3. Select the “Global Hide” button (immediately below the “Hide”
header text)

4. Scroll down the page and set the following layers to “Range”

a. Counties

b. States

c. Railroads

d. Roads

e. Roads (Major)

f. Shoreline

g. Water
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ADDING YOUR OWN OBJECTS TO THE MAP

In MARPLOT, everything you see on the map is an “object”. All “objects”
are stored in “layers”, which are stored in “maps”.

To add your own objects to MARPLOT:

1. Create or unlock a layer (when creating a layer, make sure to
“set” it to the “User’s Map”)

2. Use the left side “draw tools” to create the desired object

Creating a New Layer
1. Select the List menu

2. Select “Layer List”

3. Make sure all the existing layers are “locked” (the padlock on
the left side of the “Layer List” box should be shown as closed)

4. Select the “New” button

5. Name the layer (duplicate names are not allowed)

6. Select “OK”

Adding Objects to Layer
1. Perform either of the following actions:

a. Unlock the layer where you wish to add objects

b. Create a new layer (see Steps 1-6 above)

2. Select the desired “draw tool” from the left side toolbar

3. Move your cursor to the screen area where you wish to add the
object

4. Use the “draw tools” to create objects

Draw Tool Operations
Symbol Tool

1. Place the cursor at the desired spot and click; this will open the
“Object Settings” box where you should name the object

2. Check to see if it is “Set” to the desired layer

3. Set to “User’s Map”

4. Set “Place” to “User’s Map”
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5. Use the drop-down list to set “Color”

6. Use “Set Symbol” button to select symbol icon

Rectangle Tool and Circle Tool

1. Select the desired draw tool

2. Move the cursor to map area; “click-and-drag” so that a
rectangle area appears

3. Release the mouse; the “Object Settings” box will appear

4. Set “map” and “place” to “User’s Map”

5. Set color, line style, and fill pattern as desired

6. Select “Position/Size” button to “determine or set exact area”

Polyline Tool

1. Select the “Polyline” tool

2. Move cursor to map spot where you want the line to begin and
click-and-drag; a line will appear on the map; click-and-drag
again. This action allows you to change direction.

3. Repeat click-and-drag until finished

4. Double-click to end line drawing

5. Use “Object Settings” box to set line attributes*

Polygon Tool
Use of the “Polygon” tool requires the same operation as using the
“Polyline” tool.

1. Double-click at the end of drawing process creates an
“enclosed” object; a polyline object includes the interior area as
part of its area

*Note:  Drawing an object with the polyline tool does not create
and enclosed area!  Use the polygon tool instead.
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Drawing Exact Size Circles
1. Select the “circle” tool

2. Move cursor to map location where you wish to create a circle

3. Click-and-drag to create any size of circle

4. Select “Position/Size” from the “Object Settings” box

5. Enter the desired radius of circle to the “radius” box

6. Select “OK”

Drawing Objects “From Center” or “From Corner”
Four of the MARPLOT tools may be set to “draw” from either the “corner”
or the “center”. These four tools are:

M Pointer Tool

M Zoom In Tool

M Rectangle Tool

M Circle Tool

To set any of these for either “corner” or “center”, double-click the
desired tool and select desired draw option.
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CHANGING OBJECT COLOR, SYMBOL, SIZE, AND FILL PATTERN

Setting Object Display as Identical for an Entire Layer
1. Select the List menu

2. Select “Layer List”

3. Scroll and highlight the layer you wish to edit

4. Set the “checkmark” to the “2 blue flags” box on the right side
of the “Layer List” box

Allowing Different Object Display Characteristics within a
Layer
This process is the same as above, except you will set the layer
“checkmark” to the “1 blue flag, 1 red flag” box.

Determining the Area of a Polygon or Rectangle
1. Double-click the desired object

2. Select the “Position/Size” button from the “Object Settings” box;
the exact area enclosed in the object is given*

*Note: You may use the Position/Size function to set
the exact radius for a circle. Draw any size circle on the
map, then use the Position/Size box the enter your
exact desired radius size.

○

○

○

○

○

○

○

○

○

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

○

○

○

○

○

○

○

○

○

○

○

○ ○ ○ ○



marplot ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

54

Setting Object Size, Color, and Appearance for an Entire
Layer

1. Select the  “List menu”/”Layer List”

2. Highlight the layer you wish to change

3. Set the layer to the “2 blue flags” box

4. Select the Default Graphics “Set” button

5. Select attribute; make changes and select “OK”

Setting Object Size, Color, and Appearance for an Individual
Object
Objects in layers checked “1 blue flag, 1 red flag” may exhibit individual
display attributes.

1. Double-click on the object you wish to alter

2. Identify the layer containing that object

3. Open the “List/Layer List”

a. Set desired layer to “1 blue flag, 1 red flag” box

b. Unlock the layer

4. Select “OK”; the desired object should still be “selected”

5. Select the “Objects” menu

6. Select color, line style, fill pattern, and/or symbol as
appropriate to make changes

Setting Object Size, Color, and Appearance for a Group of
Objects

1. Use the Search, Quick Search, or “point-and-SHIFT-click”
function to select a group of objects

2. Select the “Objects” menu

3. Select color, line style, fill pattern, and/or symbol as
appropriate to make changes
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Graphics Override Function

This message is telling you the layer you are working in is set to the “2
Blue Flags” box; meaning all objects in this layer will have the same
display attributes.

Deleting Objects from MARPLOT Maps

1. Click on the object you wish to remove

2. Select the “Delete” button on your computer keyboard

If this message appears, you need to “unlock” the layer for this object.

To determine the layer location for any object, double-click on the
object. This will display the “Object Settings” box for that object, which
lists the layer where this object is stored.
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MARPLOT SEARCHES

Basic MARPLOT Search Operations

MARPLOT searches are always formatted as: “search for objects in
layers on maps.

The goal of a MARPLOT search is one of the following:

M to “find”

M to “display”

M to “select”

an object or group of objects.

MARPLOT search criteria is defined by your selection of one of the
following:

M Search Operator

M Search Layer(s)

M Search Maps(s)

MARPLOT Search Operators
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MARPLOT Search Layer Options

MARPLOT Search Map Options

The remaining search criteria is to either:

M Replace previous collection (NEW search)

M Add to previous collection (OR search)

M Subset of previous collection (AND search)
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Quick Search Function

1. Select the pointer tool

2. Point at the map area you wish to search

3. Click-and-drag; a rectangle or circle area will appear on the
screen

4. When the area you wish to search is contained in the circle or
rectangle, release the mouse

The “active” layers are displayed in a box. Use your mouse to “select”
the layer(s) you wish to include in your search. In the example box
below, three layers have been “selected” to include in the search.

5. Select the “Select” button

All objects from the indicated layer(s) will now be “selected”.*

*Note: “Quick Search” conducts an “inside
of or touched by” search.  The “currently
selected object” is the rectangle or circle
“drawn” when you left-click and drag with
your mouse.
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Searching the Area for CAMEOfm Records

Custom MARPLOT Search
If CAMEOfm records have been “linked” to MARPLOT objects, you may
search any user-defined area for those CAMEOfm records. Traditionally,
CAMEOfm records are locations such as:

M Chemical Facilities (Tier 2 reporters)

M Places with “special” populations (i.e., Hospitals, Nursing
Homes, Day Care Centers, Prisons)

M Places with available resources (i.e., Fire Stations, Police
Stations, Public Works Yards, EMS Stations)

Every CAMEOfm system is unique. You must KNOW what records are
available via CAMEOfm/MARPLOT in order to effectively search for them.

The example below searches for CAMEOfm records in layer(s) named
CAMEO Facilities, CAMEO Special Locations, and CAMEO Day Care
Locations. YOUR SYSTEM WILL NOT INCLUDE THESE  SPECIFIC
LAYERS UNLESS SOMEONE HAS CREATED THEM!

Notice the search operator is “that are inside of or touched by”. This will
select only objects inside the user-specified search area. Also notice the
layer(s) to search is “Multiple Layers”. This allows you to search several
MARPLOT layers simultaneously.
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Searching the Area for Landview Records

Custom MARPLOT Search
If you are using Landview, you may search for Landview records within
any user-specified area. Landview records are found in five layer groups:

M Census 2000 Demographic Layers

M Census TIGER/Line 2000 Layers

M EPA Layers

M USGS – Federal Lands Layers

M USGS – GNIS Layers

Here are two example searches:

1. Search for any airport within two miles of the release point

2. Search for EPA Sites, Hospitals, and Indian Areas within the
user-selected circle, rectangle, or polygon area



cameo companion for responders○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

61



marplot ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

62

VIEWING CAMEOFM OR LANDVIEW RECORDS AFTER A
MARPLOT SEARCH

After MARPLOT has “returned a found set”:

1. Select “Show All On Map”

2. Select the “Sharing” menu

3. Select either “CAMEOfm” or “Landview” as appropriate

4. Select “Get Info”; this should activate and open the selected
records.

VIEWING AN AERIAL PHOTO OF THE AREA (INTERNET FUNCTION

ONLY)

Landview 5 Internet “Web Link” Function (GNIS Layer)
All Landview USGS/GNIS records feature a direct internet link to the
USGS TerraServer website. This allows users to view topographic and
aerial photo maps.

To access the TerraServer maps and photos:

1. Activate Landview

2. Click on the “USGS Geographic Names Database” button

3. Select or highlight any record from the list (if a single record
sheet is currently displayed, select the “View as List” button)

4. Select the “Web Link” button

5. If your Internet link is active, the screen will open to the
TerraServer page for the selected USGS/GNIS record
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6. To view the topographic map for the area, select “View USGS
Digital Raster Graphic or TopoZone.com”

7. To view the aerial photo for the area, select “View USGS Digital
Orthophoto Quadrangle (DOQ)”

The aerial photo in the example below is “South Tuscon”.

8. To enlarge the aerial photo, select the “Map Size” drop-down list
on the left side of the screen and change to “Large”

9. To “Zoom In” to a location, use your cursor to point at the area
you wish to zoom in and click.
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SAVING THE AERIAL PHOTO TO YOUR COMPUTER

1. Select the map area you wish to “save”

2. Right-click on that area with your mouse

3. Select “Save Picture As” and use the browse box to name and
save the photo to your computer

4. If you are going to display the photo to MARPLOT, make sure to
save it as a bitmap (.bmp) file

Displaying an Aerial Photo on MARPLOT Map
MARPLOT will display any bitmap image file. Therefore, any aerial photo
shot that has been “saved” as a bitmap file can be shown on a MARPLOT
map.

1. Activate MARPLOT

2. Set the viewscreen to the approximate area of the aerial photo
you wish to display

3. Open or create a MARPLOT layer

4. Select the “Edit” menu

5. Select “Insert Picture Object”

6. Select “Use Existing Map”

7. Select “File”

8. Use the “Choose Picture File” browse box to locate the photo
and double-click on the bitmap photo file
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9. You will now see the “Object Settings” box

10. Select “OK”; the bitmap image should now display on the
MARPLOT screen

Moving and Resizing the Inserted Photo
1. Select the photo (it should be “surrounded” by four “red

squares”)

2. To move, place your cursor inside the photo area and click-and-
drag with your mouse

3. To resize, place your cursor on any of the “red squares” and
click-and-drag with your mouse

SELECT THE AERIAL PHOTO FROM MARPLOT
The aerial photos are linked to Landview USGS GNIS records. You may
“select” any single GNIS record from MARPLOT and move to the internet
aerial photos.

1. Activate MARPLOT

2. Set your view for the area you wish to see the aerial photo

3. Select the “List/Layer List” menu

4. Set the USGS GNIS Layer to “Show”

5. Select any GNIS symbol from the map

6. Select the “Sharing” menu

7. Select “Landview/Get Info”; this should activate the selected
GNIS record in Landview

8. Select the “WebLink” button
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Displaying a CAMEOfm Facility Site Plan in MARPLOT
MARPLOT will display any bitmap image file. Therefore, any site plan
that has been “saved” as a bitmap file can be shown on a MARPLOT map.

If the site plan has been saved as a .jpg, .tif, or .gif file, use a photo
editor program to change it to a bitmap file. Nearly all computers have a
photo editor software installed. Some common ones are Paint, Photo
Studio, and PhotoShop. Any of these should allow you to change a jpeg
(.jpg) or gif (.gif) to a bitmap (.bmp) file.

Many CAMEOfm users have entered site plans to CAMEOfm and linked to
the Facility or Special Location record. Those site plans will be located in
the CAMEOfm “Site Plans” folder. The following is one method of
displaying those site plans in MARPLOT.

To find the site plan:

1. Minimize all active screens

2. Right-click on the “Start” button, found on the lower left side of
your computer

3. Select the “Explore” button

4. Find and “open” the CAMEOfm “Site Plans” folder
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5. If needed, change the desired site plan to a bitmap file; then
close the “Site Plans” folder

6. Activate MARPLOT

7. Open or create a MARPLOT layer

8. Select the “Edit” menu

9. Select “Insert Picture Object”

10. Select “Use Existing Map”

11. Select “File”

12. Use the “Choose Picture File” browse box to located the photo in
the CAMEOfm “Site Plans” folder; this is usually on your C/:
drive

13. Double-click on the bitmap photo file

14. You will now see the “Object Settings” box

15. Select “OK”

The site plan file should now be displayed on the MARPLOT map. The
image may be moved or resized (see Moving and Resizing the Inserted
Photo).*

*Note: The Insert Picture Object function works for any bitmap
file. For more complete instructions on methods to “autolocate”
bitmap files inserted into MARPLOT, see CAMEO Companion for
Planners.
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SAVING AND PRINTING MARPLOT MAPS

File/Print Function
1. Activate MARPLOT

2. Select the “File” menu

3. Select “Print”

You may select “Landscape” or “Portrait”; it is recommended that you
print both types to decide which is preferred.

4. Close Print Setup

5. Select “File” menu

6. Select “Print”

Your printer should “print” an exact copy of your screen.

Save as a Picture Function
1. Select the “File” menu

2. Select “Save as Picture”

3. Use the browse box to name and save the file

This is now a bitmap file, you may treat it as any other image file (i.e.,
print, edit, or e-mail).*

*Note: You may “change” the bitmap file to a .jpg or
.gif file using a photo editor software.
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MARPLOT ShortcutsMARPLOT ShortcutsMARPLOT ShortcutsMARPLOT ShortcutsMARPLOT Shortcuts

MARPLOT features several built-in functions which access different
menu selections. This unit will introduce you to some of those built-in
functions.

TITLE LINE TOOLBAR

Just below the menu bar are three drop-down menus that access several
other menu items. They are:

M Focus Point

M Scale Display

M Reference Info

A complete discussion of these menu bars is given in the Help section.
This unit focuses on some of the more common usages of these
“shortcuts”.

1. Use the “Selection” tool to open the “Focus Point” drop-down
menu. It should look like this.

Note:  This section is reprinted from the Introduction to CAMEOfm Course
materials used by the author.  As such, the “format” for this section is different than
previous sections of the CAMEOfm Companion  for Responders book.  It is included
to demonstrate some MARPLOT functions that you may find useful.
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2. Select “Coordinate Format”. Notice it is exactly the same
screen as seen earlier in the File/Preferences/Latitude/
Longitude dialogue box!  You may now “set” or “change” Lat/
Long format identically as shown in the earlier course unit.

3. Close that box and select “Go To Lat/Long”. Notice you again
have the option of selecting your Lat/Long format!
Additionally, you have the option of entering a specific Lat/Long
value, and MARPLOT will reposition the “cursor” mark to that
Lat/Long place. This exact same function can be found under
the View menu.

Notice the bottom four items are inactive. These may be used ONLY
when a “line” object is selected.

4. Use your mouse to click on the “Scale Display” drop-down menu.

Here are more MARPLOT functions seen in earlier course units.

1. Select “Scale Format”. You are again sent to the File/Preferences
menu!  Do you recognize the “Scale Format” text box?

2. Select “Zoom In”; Notice this works identically to the “Zoom In”
tool located on your left side toolbar.

3. Select  “Set Scale”; Isn’t this text box identical to the one you
used earlier in the View menu unit?

4. Use you mouse to open the remaining title line drop-down
menu.
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Do you recognize these menu items?  Aren’t most of these in the View
menu?

These are all shorcturs to allow you to utilize MARPLOT more efficiently.
These are not separate functions!  They simply access specific menu
items.

Two shortcuts are available from the left side toolbar. Notice that two of
the five upper tools have “drop-down menu” indicators. They are the
“Selection” tool and the “Zoom In” tool.

1. Double-click on the “Selection” tool. Notice you can now choose
between “rectangle” or “circle”

2. Double-click on the “Zoom In” tool. Your choices are now “from
corner” or “from center”. Both of these are short cuts to the File/
Preferences/Tools menu.

Let’s see how these two functions are used:

1. Use your mouse to highlight the “Selection” tool

2. Move your mouse to any spot on the map

3. Click once and hold the mouse left button down

4. Drag the mouse; a “dotted line” rectangle should appear on the
screen

5. Release the mouse button after dragging for a while. A “Select
on Layers” text box should appear.
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Again, your “list” inside the “Select on Layers” box will be different than
the one shown here. You may now “choose” which layers contain objects
you wish to “select” by simply using your mouse to “check” the desired
layers. This process is also called a “Quick Search” because it allows you
to “select” a group of objects in much the same way as a search.

1. Use your mouse to “check” the Water Features layer

2. Select the “Search” button. Are all the Water Features contained
inside your drawn “box area” now “selected”?  They should be.

3. Double-click on the Selection tool and change to the “circle”

4. Repeat the process as above, only this time you will be
searching inside of a circle
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The “Zoom In” tool also has a shortcut to the File/Preferences/Tools
menu.

1. Use the mouse to highlight the “Zoom In” tool

2. “Click-and-drag” as in the above example

When you release the mouse button, your display screen is resized to fit
the rectangle drawn by the “Zoom In” tool!

3. Change the “Zoom In” tool to “from Center” and repeat the
exercise.
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Setting ALOHA Defaults (Site Data Menu)Setting ALOHA Defaults (Site Data Menu)Setting ALOHA Defaults (Site Data Menu)Setting ALOHA Defaults (Site Data Menu)Setting ALOHA Defaults (Site Data Menu)

CHOOSING A LOCATION FROM THE ALOHA LOCATION LIST

1. Activate ALOHA

2. Select the “Site Data” menu

3. Select “Location”

4. Scroll and select the “city” closest to the release point

ADDING YOUR OWN LOCATION TO THE ALOHA LOCATION LIST

To ADD your own location to the ALOHA City List, you will need to

know:

M Lat/Long in Degrees/Minutes

M Elevation in Feet or Meters

1. Open the ALOHA “Location List” box (see above)

2. Select “Add” button

3. Enter data to available text fields*

4. Select “OK”

SETTING PARAMETERS FOR BUILDINGS DOWNWIND OF THE RELEASE

POINT

1. Select the “Site Data” menu

2. Select “Building Type”*

3. Only use “No. of air changes per hour” if you can accurately
determine that information

SETTING THE DATE AND TIME

ALOHA defaults to “real time” taken from your
computer clock. You may set a constant time,
either a “future” time (for planning purposes),

or a “past” time (for accident investigations).

* Note: Remember to
select the correct “state”
from the list.

* Note:  This is for
buildings DOWNWIND of
the release,  not a building
from which the release
occurred.  ALOHA uses the
“Building Type”
information in its Indoor
Concentration/Dose
calculations.
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*Note: In some cases, the CAMEOfm/ALOHA “Sharing” menu
allows you to navigate between the RIDS information and the
ALOHA program. However, you can achieve the same functionality
by selecting the substance in both programs and using the bottom
task bar to transport between CAMEOfm and ALOHA.

ALOHA InputsALOHA InputsALOHA InputsALOHA InputsALOHA Inputs
ENTERING RELEASE INFORMATION: SETUP MENU

Selecting the Chemical

ALOHA Chemical Library

1. Select the “Setup” menu

2. Select “Chemical”

3. Choose “Pure Substance” or “Solutions”*

4. Scroll (or use Quick Typing from below) to locate the desired
chemical

5. Select “OK”

“Quick Find” Typing Function

1. Open the ALOHA
Chemical Library

2. Quickly type the first
three (3) or four (4)
letters of the chemical name*

Using the CAMEOfm RIDS to ALOHA Link

1. Find the desired chemical in the CAMEOfm Chemical Library

2. Select the “Sharing” menu

3. Select “ALOHA”/“Select this Chemical in ALOHA”

*Note: The ALOHA 5.3 “Solutions” list incorporates the NOAA “Evaporation
Calculator” for five chemicals.

*Note: You  may add to or modify
substances in the ALOHA Chemical
Library (see CAMEOfm Companion for
Planners/Managers).
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What is Being Released? Chemical Menu
1. Select the “Setup” menu

2. Select the desired chemical from the ALOHA Chemical Library

3. Select “OK”

What’s the Weather Like? Atmospheric Menu*
ALOHA allows for three types of weather data entry. These data types
are:

M User-input of weather conditions

M Connection to any of a number of SAM or MET stations; a list of
vendors with ALOHA-integrated portable weather stations is
available on the CAMEOfm Website, under the Support Forum
link

M ALOHA’s built-in “fake” SAM station (use for training purposes
only)

Manually Entering Weather Conditions
1. Select the “Setup” menu

2. Select “Atmospheric”

3. Select “User Input”

4. Enter user-estimated weather conditions

Using a “MET” or “SAM Station”
1. Select the “Setup” menu

2. Select “Atmospheric”

3. Select “SAM station”

4. Select the appropriate COM option (Serial Port); usually this will
be COM-1

5. Select “OK”

6. Enter Inversion, Ground Roughness, and Station Height data

7. Enter Cloud Cover and Humidity data
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ALOHA will take approximately five minutes before displaying weather
data. You must wait for the first weather data transmission before
continuing with Source Data input.

Using the ALOHA “Demo” SAM Station
1. Select the “Setup” menu

2. Select “Atmospheric”

3. Depress and hold the Control (CTRL) key on your computer
keyboard

4. Select “SAM Station”

You should see this box on your computer screen.

Continue with ALOHA screens as if enabling a “real” SAM station.*

*Note: Use “fake” SAM station for
training purposes only!

○

○

○

○
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HOW MUCH AND HOW FAST IS THE PRODUCT BEING RELEASED?
SOURCE MENU

Using the ALOHA “Direct” Source Option when only a “Total
Amount Released” is Known*

1. Select the “Setup” menu

2. Select “Source”

3. Select “Direct”

a. Select desired units

b. Select Instantaneous

c. Enter estimated total release amount

d. Enter Source Height

*Note: This is critical  input information for ALOHA. ALOHA depends on accurate
release rate input data to accurately produce downwind concentration estimates.
The more accurate the Source Input Data ,  the more accurate ALOHA’s output
data.

The Direct/Instantaneous Source option generally represents a “worst-case”
scenario. You must enter only the total amount released.
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Using the ALOHA “Direct” Source Option when the “Total
Amount Released” and “Total Time Elapsed” are Known*

1. Select the “Setup” menu

2. Select “Source”

3. Select “Direct”

a. Select desired units

b. Select “Continuous”

c. Calculate the release rate

i. Divide total amount released by “minutes” (e.g., 1500
pounds divided by 30 minutes = 50 pounds per minute

ii. Enter user-calculated release rate

4. Select “OK”

5. Review Text Summary/Source Strength information to ensure
Total Amount Released is correct.

○

○

*Note: Using the Direct/Continuous Source option requires you to “know” the
amount of product released during a specific time period, and will produce more
“accurate” results than the Direct/Instantaneous Source option. You may find the
Continuous Source option particularly useful for review of past chemical spills,
when the release amount and time duration may be known or effectively
estimated.

○ ○
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Using the ALOHA “Puddle” Source Option
General “puddle” releases require you to “know” the puddle surface area
(size) and any one of these three parameters:

M Gallons, Liters, or Cubic Feet of Product: Use “volume of
puddle”

M Pounds, Grams, or Tons of Product: Use “mass of puddle”

M Average Puddle Depth: Estimate puddle on flat surface as 0.5
inches

Storage Tanks with Containment
You may utilize a “puddle source” when a product is released into a
containment area. However, the “Tank Source” option also allows you to
specify containment area dimensions, and may more accurately
estimate release data (see Tank Source ).
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*Note: Many gaseous substances
are stored as a “liquid under
pressure”. Some common ones
are Chlorine, Propane, Ammonia.
ALOHA considers these chemicals
“Liquids”. You should NOT model
these as “gases” in ALOHA (see
“Liquefied Gases”).

Using the ALOHA “Tank Source” Option
Tank Source can be used for either gas or liquid substances. Tank
Source requires you to know or estimate:

M Tank Dimensions: length, diameter, and capacity

M Physical State of Chemical: liquid or gas

M Amount in Tank: pounds, gallons, or cubic feet; or tank
pressure

M Release Point Dimensions: hole size or valve size*

Tank Source for “Gases”
1. Select the “Setup” menu

2. Select “Source”

3. Select “Tank”

4. Select “Tank Type”

5. Enter any two of the following
(for spherical tanks, enter only
either “Diameter” or “Volume”)”

a. Diameter

b. Length

c. Volume

6. Select “OK”

7. Select “Tank contains gas only”

8. Enter appropriate temperature
value

9. Enter either Tank Pressure or Tank Volume

10. Enter Hole Size and Location*

Tank Source for “ Liquids” and “Liquefied Gases”
1. Select the “Setup” menu

2. Select “Source”

3. Select “Tank”

4. Select “Tank Type”

○

○

○

○

○

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

*Note: ALOHA will
automatically compute many of
the tank and amount parameters
based on your inputs. It is not
necessary for you to “know”
values for all ALOHA Tank
Source input fields.

○ ○ ○ ○ ○ ○

○

○
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5. Enter any two of the following (for spherical tanks, enter only
either “Diameter” or “Volume”):

a. Diameter

b. Length

c. Volume

6. Select “OK”

7. Select “Tank contains liquid”

8. Enter any of the four available fields:

a. Mass

b. Volume

c. % Full

d. Adjust Slider Bar

9. Enter Hole Size and Location

For Tanks Containing Liquids with Containment Area
The final input screen for liquids allows you to input “puddle
parameters”, including type and size of any “dike” or “containment
area”.

You may input dimensions of a containment area surrounding a tank as
either a “diameter” or “area”, and ALOHA will compute a release
duration based on those parameters. The screenshot above lists a
“containment area” expressed as “200 square feet”.
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ALOHA Outputs: Display MenuALOHA Outputs: Display MenuALOHA Outputs: Display MenuALOHA Outputs: Display MenuALOHA Outputs: Display Menu

THE ALOHA “3 LOC VALUE” FOOTPRINT

1. Select the “Display” menu

2. Select “Footprint”

3. Set the LOC values, if desired

4. Select “OK”*

For more information on Level of Concern choices, see NOAA website,
Level of Concern Page at http://response.restoration.noaa.
gov/cameo/locs/LOCpage.html.

Changing the Level of Concern: Temporary (Display/Footprint
menu)

1. Select the “Display” menu

2. Select “Footprint”

3. Click on the drop-down arrow for each LOC value

4. Select desired “LOC value” from the drop-down list

*Note: ALOHA version 5.3 automatically sets for three LOC values. You may
select to display one, two, or three footprints by changing the LOC values.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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5. Select “user specified”

6. Enter your chosen LOC values

7. Select “OK”

Changing the Level of Concern: Permanent (ALOHA Chemical
Library menu)

1. Select the “Setup” menu

2. Select the desired chemical from the ALOHA Chemical List

3. Select “Modify”

4. Select “Default LOC-1 (Yellow)”

5. Enter desired LOC value

6. Set units to either “ppm” or “mg/(m3)”

7. Repeat Steps 4 - 7 for both LOC-2 (Orange) and LOC-3 (Red)*

*Note: This process will permanently set the LOC to user-specified concentration
values. The “largest” LOC value MUST be used for LOC-3 (Red); the smallest LOC
value must be entered to the LOC-1 (Yellow) option.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
○

○

○

○

○

○

○

○

○
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Displaying Only One Footprint

1. Select the “Display” menu

2. Select “Footprint”

3. Click on the drop-down arrow for the “LOC-1 (Red) Footprint”

4. Set to “none”

5. Repeat Steps 3 and 4 for the LOC-2 (Orange) Footprint

6. Set the “LOC-3 (Yellow) Footprint LOC” to the desired value

7. Select “OK”
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ALOHA TALOHA TALOHA TALOHA TALOHA Time-Dependent Information:ime-Dependent Information:ime-Dependent Information:ime-Dependent Information:ime-Dependent Information:
Concentration, Dose, Source StrengthConcentration, Dose, Source StrengthConcentration, Dose, Source StrengthConcentration, Dose, Source StrengthConcentration, Dose, Source Strength

SETTING AND VIEWING THE CONCENTRATION AND DOSE GRAPHS IN
ALOHA
There are two methods from establishing the concentration and dose
points in ALOHA.

Method 1:

1. Select the “Display” menu

2. Select “Concentration”

3. Enter the desired downwind and off-axis distances

4. Select “OK”

Method 2:

1. Display the ALOHA footprint

2. Use your mouse to select the desired concentration point

3. Double-click

After either method, the concentration graph will appear on your
screen.

To view the Dose Graph:

1. Select the “Display” menu

2. Select “Dose”

The Dose Graph will appear on your screen. The Dose Point is ALWAYS
identical to the Concentration Point.
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SETTING AND VIEWING THE CONCENTRATION AND DOSE GRAPHS IN
MARPLOT
You may set the concentration and dose points directly from MARPLOT.

1. Activate MARPLOT while the ALOHA footprint is displayed

2. Select the pointer tool

3. Use your mouse to set the pointer tool at the desired
concentration point

4. Click once

5. Select the “Sharing” menu

6. Select “Set Conc/Dose point”

The concentration graph for the selected point will now be displayed on
your screen.
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Estimating Length of Time for the Vapor to Reach a Specific
Point

1. Activate MARPLOT while the ALOHA footprint is displayed

2. Select the pointer tool

3. Use your mouse to set the pointer tool at the desired point

4. Click once

5. Select the “Sharing” menu

6. Select “Set Conc/Dose point”

You may now estimate the length of time for the contaminate to reach
the selected point by interpreting the concentration graph. Time
elapsed is shown on the X-axis.

Estimating Chemical Amount at a Specific Point Over Time
1. Repeat Steps 1 – 6 from above

2. Use the resulting concentration graph to estimate the amount
and length of time the chemical is present at the selected point

What do I do if the Concentration Graph does not appear?
If you get the following message, your selected point is outside the
ALOHA-predicted contaminated area.

If ALOHA fails to “open” after a “Sharing/Select Conc/Dose” command,
the most likely cause is a lost connection between ALOHA and
MARPLOT. You can check the connection status by returning to ALOHA,
altering the footprint in some manner, then return to MARPLOT to see if
the ALOHA changes have been reflected in the map. If not, you will
likely need to reboot your computer.
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Estimating Length of Time for Tank to Become Empty or
Puddle to Evaporate (Display/Source Strength menu)
ALOHA provides estimates of the time necessary for a tank to empty or
a puddle to evaporate or volatilize. Under the “Display/Source Strength”
menu, the information is given in graphical format. The Text Summary
provides the information in a text format.

ALOHA’s Estimate of Time for “Tank” to Empty or “Puddle” to
Volatilze
Review the Text Summary/Source Strength Information/Release
Duration for ALOHA’s estimate of time necessary for the tank to empty
or a puddle to disappear. It is given as “Release Duration”. “Release
Duration” does not, however, necessarily mean the tank is empty.
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Estimating Time for “Tank” to Empty or “Puddle” to Volatize
Review the Text Summary/Source Strength Information/Release
Duration for ALOHA’s estimate of time necessary for the tank to empty
or the puddle to disappear. Sometimes, the Release Duration will
display “ALOHA limited the duration to 1 hour”. This means the release
of product into the atmosphere continues after the 60 minute ALOHA
limitation period.

To produce your own release duration estimate for either Tank or
Puddle Sources:

1. Find the “Max Average Sustained Release Rate” value in the Text
Summary

2. Estimate “total amount of product released”

3. Divide “total amount” by “max average sustained release rate”

4. Make sure your “units” are consistent (i.e., do not use “pounds”
for the total amount with “gallons” for average release rate)

Example:

a. 600 gallons of product was spilled

b. ALOHA estimates a release rate of 5.29 pounds per minute

c. Convert product “gallons” to “pounds” (e.g., assume product
specific gravity is 1.19 [this is the Hydrochloric Acid value from
RIDS]) In this example: 1.19 S.G. multiplied by 8.33 lbs per
gallon multiplied by 600 gallons = 5948 Total Pounds

d. Divide Total Pounds by Release Rate (In this example: 5948
Total Pounds divided by 5.29 pounds per minute = 1124
minutes (or 18 hours) total release time duration [this is a
conservative estimate])
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Using ALOHA to Predict a PotentialUsing ALOHA to Predict a PotentialUsing ALOHA to Predict a PotentialUsing ALOHA to Predict a PotentialUsing ALOHA to Predict a Potential
Ignition AreaIgnition AreaIgnition AreaIgnition AreaIgnition Area

SETTING UEL, LEL, AND 10% LEL AS LOC VALUES

Upper and Lower Explosive Limits (UEL and LEL) may be used as ALOHA
LOC values. First, you must find the UEL and LEL values for the desired
chemical. These may be found in the CAMEOfm RIDS Properties section.

UEL and LEL values are always given as a percentage (%) and must be
converted to “ppm” for entry to ALOHA Chemical List. The conversion
equation is: 1 % = 10,000 ppm. For example,  if the LEL is 4.9%, then
ppm equals 49,000 (4.9 %  multiplied by 10,000).

1. Select the “Setup” menu

2. Select the desired chemical from the ALOHA Chemical List

3. Select “Modify”

4. Select “Default LOC-1 (Yellow)”

5. Enter 10% of LEL in ppm units

6. Select “LOC-2 (Orange)”

7. Enter LEL in ppm units

8. Select “LOC-3 (Red)”

9. Enter the UEL in ppm units*

*Note: The resulting ALOHA footprint
will display footprints where airborne
concentrations of the released product
are predicted to exceed UEL, LEL, and
10% of LEL values.

○

○

○

○

○ ○ ○ ○ ○ ○○

○

○

○

○

○

○

○

○

○

○ ○ ○ ○ ○
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Using RMP-COMP to Predict an ExplosionUsing RMP-COMP to Predict an ExplosionUsing RMP-COMP to Predict an ExplosionUsing RMP-COMP to Predict an ExplosionUsing RMP-COMP to Predict an Explosion
ZoneZoneZoneZoneZone

To download RMP-COMP at no cost, see Acquiring the Software.

To use RMP-COMP to predict a one-pound overpressure area
resulting from some type of Vapor Cloud Explosion or a BLEVE:

1. Open RMP-COMP

2. Select the appropriate chemical or mixture

3. Enter field items as indicated

RMP-COMP results are in “radius” format. Use the MARPLOT toolset to
position and size the RMP-COMP suggested area on the MARPLOT map.
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DISPLAYING ALOHA FOOTPRINTS ON MARPLOT MAPS*

Displaying ALOHA footprints on MARPLOT maps always begins by
having the MARPLOT map active.

1. Open or activate MARPLOT

2. Select the pointer tool (or arrow tool)

3. Use your mouse to position the “pointer” at the release location
and click once

4. Open the “Sharing” menu

5. Select “ALOHA”

6. Select “Set Source Point”

The ALOHA footprint(s) should now be displayed at the selected source
point.

What if the footprint does not appear (see the Troubleshooting Section)?

MOVING THE ALOHA FOOTPRINT TO A DIFFERENT MAP LOCATION

Unlike other MARPLOT “objects”, you cannot “click-and-drag” an ALOHA
footprint. To relocate the ALOHA plume, you must “select” a new source
point by repeating Steps 1 – 6 above.

CHANGING ALOHA CONDITIONS, THEN SHOWING NEW FOOTPRINT

IN MARPLOT
The communication between ALOHA and MARPLOT is “always active”.
Thus, ANY change to the ALOHA footprint(s) (e.g., selecting a new LOC,
changing the wind direction, selecting a different source option, or
altering the release rate) will change the dimensions of the ALOHA
footprint. The changes will automatically be displayed in MARPLOT.

SAVING THE ALOHA FOOTPRINT IN MARPLOT BEFORE

CHANGING ALOHA CONDITIONS

You may wish to “keep” the previous ALOHA footprint dimensions
visible while altering ALOHA parameters. This will allow you to
“compare” the various ALOHA footprints.

*Note: Communication between ALOHA and MARPLOT is accomplished via the
“Sharing” menu available in either program.

○

○
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To “save” an ALOHA footprint, you must use the MARPLOT “draw
tools”:

1. Move to MARPLOT with the ALOHA footprint displayed

2. Select the List menu

3. Select “Layer List”

4. Select the “New” button

5. Name the new layer (e.g., “ALOHA footprints”)

6. Select “OK”; the MARPLOT screen should now display the “draw”
tools on the left side toolbar.

7. Select the “polygon” tool

8. Use the “polygon” tool to “trace” the ALOHA footprint(s)

9. Name the resulting polygon (e.g., “ALOHA Direct/Instantaneous
Footprint” or “ALOHA Chlorine IDLH Footprint”)

10. Associate the new polygon with the User’s Map

11. Select “OK”

You are now ready to return to ALOHA and change the input parameters
as desired. The ALOHA footprint will automatically be “updated” on
MARPLOT, and the “user-drawn” will also be displayed. This allows
comparisons between the two footprints.*

*Note: In the screenshot above,  the blue polygon is a “user-drawn” copy of the 1st

ALOHA footprint. The yellow polygon is the “active” ALOHA footprint, which has
a higher LOC than the original, or blue, footprint.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
○

○

○
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DISPLAYING ALOHA FOOTPRINTS ON OTHER MAPS: ARCVIEW,
MAPINFO, AND PAPER MAPS

ALOHA and ArcView
ALOHA footprints can be displayed on ArcView products. The
instructions are available from the NOAA website at http://
response.restoration.noaa.gov/cameo/dll8.html.

ALOHA and MAPInfo Professional
ALOHA footprints can be displayed on MAPInfo Professional . The
instructions and PlotALOHA Application download are available from the
CAMEOfm website at http://www.uaienvironmental.com/PlotALOHA.asp.

ALOHA and Paper Maps
You can manually attach ALOHA footprints on printed paper maps (such
as, ordinary roadmaps, assessment maps, and floodplain maps). The
key element is “matching” the ALOHA output scale with the desired map
scale. One method for doing so is:

1. Examine the desired paper map to determine its “scale”; the
scale MUST be expressed as either “1 in = ____”; or “1 cm = ____”

2. Create a footprint in ALOHA, and then select the “Display menu”

3. Select “Options”

4. Select “Use user-specified scale”

5. Select “OK”

6. Set the ALOHA scale to same values as the paper map scale

7. Select “OK”

8. Print the ALOHA footprint

9. Attach the printed footprint to the paper map

Optional: You could print the ALOHA footprint on a transparency. Also,
you could “trace” the ALOHA footprint onto the paper map.*

*Note: The ALOHA footprint will not be “wind direction” justified. You
will need to “orient” the printed footprint as per current wind direction.

○

○

○

○

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

○

○

○

○

○
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ALOHA Outputs: Printing, and SavingALOHA Outputs: Printing, and SavingALOHA Outputs: Printing, and SavingALOHA Outputs: Printing, and SavingALOHA Outputs: Printing, and Saving
VIEWING ALOHA OUTPUTS: TEXT SUMMARY, FOOTPRINT, CONC

GRAPH, DOSE GRAPH, AND SOURCE STRENGTH GRAPH

Each of the ALOHA outputs can be viewed individually or
simultaneously. As you “select” each output item from the “Display”
menu, the item will display on the screen.

To view all ALOHA outputs simultaneously:

1. Select the “Display” menu

2. Select “Tile Windows”; all “active” ALOHA outputs will be
displayed on your screen.

PRINTING ALOHA OUTPUTS: TEXT SUMMARY, FOOTPRINT, CONC

GRAPH, DOSE GRAPH, AND SOURCE STRENGTH GRAPH

Active ALOHA outputs may be printed individually or simultaneously.

1. Select the “File” menu

2. Select “Print”; the currently active output will print

You can also select “Print All” to print all output screens.

Printing ALOHA Outputs when Using a SAM Station
There are additional outputs when using a SAM station. These are also
printable using the “Print” and “Print All” menu commands.

SAVING ALOHA INFORMATION

When selecting the File/Save command, ALOHA automatically paths
your computer to the ALOHA Export Files folder. You may use the
“browse box” to path to a user-selected save folder. ALOHA files may be
“saved” only in .alo format.

1. Select “File” and then “Save”

2. Save to the “Export Files” folder or set up your own save folder

3. Name the file and select “Save”

OPENING A SAVED ALOHA FILE

ALOHA files may be opened in one of two formats:

M Response Mode

M Planning Mode
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Response Mode: The Response Mode should be chosen if ALOHA is
being used during a real emergency. As it opens the file, ALOHA will
restore all the information contained in the file that is expected to stay
the same from day to day. This information includes location, chemical
of concern, and the dimensions of existing storage vessels and
containment areas. You will need to enter information specific to your
incident, including current weather conditions and the circumstances of
the release (e.g., the dimensions and location of a hole in a tank or the
area of a puddle of spilled liquid).

Planning Mode: The Planning Mode should be chosen when you need to
be able to recreate the scenario saved in the ALOHA saved file. When
you reopen a saved file created during Planning Mode, all input values
will be restored to their state when you saved the file. If you were using
the computer’s clock, ALOHA will use the time when the file was saved
as the constant time. If you were using a MET Station, the last
transmission was used while you entered atmospheric data.

Copying ALOHA Outputs Screens to Other Software Programs
Any of the ALOHA output screens may be copied to other software
applications using the “Edit” menu’s Copy and Paste commands.

To copy a footprint screen to Microsoft Word:

1. Activate the Footprint screen

2. Select “Edit” then select “Copy”

3. Activate Microsoft Word

4. Select “Edit” then select “Paste”; the footprint will now display in
Microsoft Word.

To copy the Text Summary to Microsoft Word:

1. Activate the Text Summary Screen

2. Use your mouse to “highlight” the text you wish to copy and
paste

3. Select “Edit” then select “Copy”

4. Activate Microsoft Word

5. Select “Edit” then select “Paste”; the Text Summary will now
display in Microsoft Word.

The same steps apply to the SAM output files.
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Population EstimatesPopulation EstimatesPopulation EstimatesPopulation EstimatesPopulation Estimates
M Circle or Radius

M Area Surrounding a Line or Polyline

M Inside a Rectangle or Polygon

M Area Surrounding any Group of Objects

POPULATION ESTIMATE FOR A CIRCLE OR RADIUS

1. Select the “point” or “object”

2. Select the “Sharing” menu

3. Select “Landview”

4. Select “Landview Census 2000 Population Estimator”

This will send you to Landview and open the Population Estimator.

5. Enter a radius distance (notice the units are miles)

6. Select “Calculate Population”

The population estimate is given in the “Total Population” field. To “see”
the estimate area displayed in MARPLOT, select the “Show this radius on
map” button.



landview ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

106

POPULATION ESTIMATE FOR AN AREA SURROUNDING A LINE OR

POLYLINE (STREETS, RAILWAYS, WATERWAYS, CANALS)
1. Select the “line” or “polyline”

2. Select the “Search” menu

3. Set the search parameters as:

a. Search for objects “that are within”

b. Set the desired area surrounding the object

c. “The currently selected object(s)”

d. Layers to search “Individual Layer”

e. Select “Census Block Points” from the drop-down list

f. Select “Maps in View”

4. Select “Search”
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5. Select “Show All On Map”

6. Select the “Sharing” menu

7. Select “Landview”

8. Select “Get Info”

9. Select “Summarize”

The population estimate is given in the “population” field.
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POPULATION ESTIMATE INSIDE A RECTANGLE OR POLYGON

1. Select the “rectangle” or “polygon”

2. Select the “Search” menu

3. Set the search parameters as:

a. Search for objects “that are inside of or touched by”

b. “The currently selected object(s)”

c. Layers to search “Individual Layer”

d. Select “Census Block Points” from the drop-down list

e. Select “Maps in View”

4. Select “Search”

5. Select “Show All On Map”
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6. Select the “Sharing” menu

7. Select “Landview”

8. Select “Get Info”

9. Select “Summarize”

The population estimate is given in the “population” field.
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POPULATION ESTIMATE FOR AN AREA SURROUNDING ANY GROUP OF

OBJECTS

1. Select the group of objects using one of the possible methods:

a. “Point-and-SHIFT-click”

b. “Search”

c. “Quick Search”

2. Select the “Search” menu

3. Set the search parameters as:

a. Search for objects “that are within”

b. Set the desired “area surrounding the objects”

c. “The currently selected object(s)”

d. Layers to search “Individual Layer”

e. Select “Census Block Points” from the drop-down list

f.  Select “Maps in View”

4. Select “Search”

5. Select “Show All On Map”

6. Select the “Sharing” menu

7. Select “Landview”

8. Select “Get Info”

9. Select “Summarize”

The population estimate is given in the “population” field.*

*Note: The “area” surrounding
the various selected objects may
overlap, but the Census Block
Points are NOT double-counted.
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CAMEOCAMEOfm 1.1.2ALOHACAMEOCAMEOfm 1.1.2ALOHACAMEOCAMEOfm 1.1.2ALOHACAMEOCAMEOfm 1.1.2ALOHACAMEOCAMEOfm 1.1.2ALOHA

5.3.1MARPLOT 3.3.1LandView 55.3.1MARPLOT 3.3.1LandView 55.3.1MARPLOT 3.3.1LandView 55.3.1MARPLOT 3.3.1LandView 55.3.1MARPLOT 3.3.1LandView 5
TTTTTroubleshooting Questionsroubleshooting Questionsroubleshooting Questionsroubleshooting Questionsroubleshooting Questions

1. I have an “error message” stating a CAMEOfm “file” is damaged
and “must be recovered”.

See “CAMEOfm for Responders”; Recovering Data section

2. The “Sharing” menu does not transfer me from MARPLOT to
Landview.

If all the active windows in Landview are “minimized”, Landview
will not respond to Sharing commands.

Note:  This section does not claim to address all questions and issues users will
experience using the CAMEOfm Software Suite.  Nor are the “suggested” solutions
always the ONLY method of “solving the problem”.  The following questions and
answers are based on the author’s experience of providing support to CAMEOfm
users both in the field and in the office.
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Restore (select the “maximize” command) any Landview window
from the bottom of the Landview screen and repeat the Sharing
command from MARPLOT.

3. The “Sharing” menu does not transfer me from MARPLOT to
CAMEOfm.

Same issue as with Landview from above. If all the active
windows in CAMEOfm are “minimized”, CAMEOfm will not
respond to Sharing commands.

4. When I select “Choose This Chemical in ALOHA” from the
CAMEOfm Chemical Library “Sharing” menu, I get an error
message in ALOHA.
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The CAMEOfm Chemical Library has over 6,000 listed
substances; the ALOHA Chemical List has about 1,000; the error
message is informing you that the chemical name you have
selected in CAMEOfm is not present in the ALOHA list.

However, this does not necessarily mean the chemical you are
looking for is not in ALOHA!  The CAS# in BOTH lists must
“match”. If you have selected a CAMEOfm chemical that does not
list a CAS#, ALOHA will not recognize the substance.

5. MARPLOT and ALOHA are not displayed in my CAMEOfm
“Sharing” menu, or CAMEOfm is not displayed in my MARPLOT
“Sharing” menu.

Sometimes, the Sharing Link between the CAMEOfm softwares
becomes inactive. Installing a new version of one of the
programs may cause this, as well as other computer-related
activites.

Try closing all the programs, then open them in this order:
CAMEOfm; ALOHA; Landview; MARPLOT (open MARPLOT from
the Landview screen “Go To Map”)

If this process does not add all the program choices to the
“Sharing” menu, then try rebooting your computer and  then
open the programs in the suggested order. If that fails to work,
you may need assistance to reset your entire CAMEOfm suite
system.

6. I linked a MARPLOT object to a CAMEOfm record and the link is
not working.

Any time a MARPLOT object is moved into a different layer or
map, the “link” to CAMEOfm is lost. Importing a new dataset to
CAMEOfm may also destroy the MARPLOT link. You will need to
“re-link” the MARPLOT object and CAMEOfm record.

7. How do I move the ALOHA footprint on the MARPLOT map?

Unlike other MARPLOT objects, an ALOHA footprint does not
respond to “click-and-drag” functions. To “move” the ALOHA
Footprint: Open MARPLOT; Select the “Pointer Tool” (Arrow Tool);
Use the mouse to “point” at the desired release point; Select the
“Sharing” menu; Select “ALOHA” and “Set Source Point”

8. The ALOHA footprint will not display on the MARPLOT map.
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If you have a different Chemical Name in ALOHA, or if you have
“opened” a saved ALOHA file, the previous footprint has been
erased. You must complete the ALOHA process by entering
weather and/or source information to enable ALOHA to create a
new footprint. The “new” footprint will automatically be
displayed in MARPLOT at the same Source Point as the previous
footprint.

9. The chemical I need to model is not in the ALOHA library.

While it is possible to “Add” a chemical to the ALOHA Chemical
List, it is not recommend. Suggest you do NOT use ALOHA if
the chemical name does not appear in the ALOHA Chemical
List.

10.  ALOHA will not let me enter the “atmospheric conditions”.

Check the Text Summary. To enter “atmospheric”, you must first
have a location selected from the Site Data menu

11. ALOHA will not let me enter the “Source” information.
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Check the Text Summary. To enter “Source”, you must first have
a Chemical selected from the Setup menu.

12. ALOHA will not display a footprint.

If ALOHA displays a message as follows, it means ALOHA has
predicted a small “threat zone”.
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13. ALOHA will not display a concentration or dose graph.

Examine the footprint graph to see your selected concentration/
dose point (denoted by the “blue cross inside a circle”).

If the Concentration/Dose point lies outside the footprint area,
ALOHA displays a message:

14. I need to see all the ALOHA outputs on my computer screen at
the same time.

Select the Display menu; Select “Tile Windows”

15. When I use the MARPLOT “Sharing” menu to do a population
count in Landview, nothing happens.

If all the active windows in Landview are “minimized”, Landview
will not respond to Sharing commands. Restore (select the
“maximize” command) any Landview window from the bottom of
the Landview screen and repeat the Sharing command from
MARPLOT.

16. Landview returns a “0” for a Population Estimate.

a. There may not be any Census Block Points within your
selected MARPLOT map area. One way to check and see is to:
Activate MARPLOT; Select the Layer/Layer List menu; Set the
Census Block Points layer to Show; Visually determine if any of
the Census Block Points are within your search area.

b. Check to see if the Landview CD-ROM is in your computer.
Unless you have moved the Census data from the CD to your
hard drive, Landview needs the CD to “find” the Block Points.

c. Check to see if the Census Map is active in your MARPLOT Map
List; and that it is the correct Census Map for the area you are
searching. Check to see if the Census Map is “pathed” to the
correct drive; i.e. c:/ drive, or d:/ drive, or f:/ drive, etc.

17. The MARPLOT roads have disappeared from the screen.

a. Check your “Scale” box. You may be closely zoomed into an
area between roads. If the Scale value is very small, try zooming
out a couple of times and see if the roads now display.

b. If your Scale value is very large, try zooming in a couple of
times. Sometimes your map area is too big for the Roads layer
to display.
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c. Check to see if the Landview CD is in the computer CD tray.

d. Check the MARPLOT Map List to see if the desired “county
map” is active and correctly pathed.

e. Check your Layer List to see if the Roads layer has been set to
“Hide”

18. I am searching for a facility in CAMEOfm, and all I get are places
in Virginia.

CAMEOfm contains several “test” or “example” records when
installed; these records are taken from Prince William County,
Virginia. Additionally, if you are using a MARPLOT that was not

installed from Landview, those same Virginia records are
installed and linked to CAMEOfm.

Users should delete all the Virginia CAMEOfm records and their
associated MARPLOT objects.

19. MARPLOT error message “Your graphical changes will not show
on the map while the the given layer is in “graphics override”
mode.

This message appears after the user has altered the Object
Settings for a selected object or group of objects. To have object
display with different colors, dymbols, etc., the layer must be set
to the “1 blue flag, 1 red flag” box found on the right side of the
Layer List dialog box; Open the List menu/Layer List menu;
locate the layer you wish to edit; Set the “checkmark” on the far
right of the Layer List to the “1 blue flag, 1 red flag” box

20. The “2” MARPLOTs issue

It is quite common to install Landview to a computer that
already has MARPLOT installed, which results in “2 MARPLOT”
programs on your computer. One version of MARPLOT is likely
found on your c:drive as marplot.exe in a MARPLOT folder.
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However, Landview has also installed a version of MARPLOT,
usually found on the c: drive as marplot.exe in the LV5 folder.

This can lead to a variety of problems. Recommend you uninstall
and delete the c: drive MARPLOT folder and marplot.exe file, and
use the MARPLOT found in the LV5 folder.

21. I am searching for “East Main Street” in the Search dialog box,
but MARPLOT cannot find it.

For best Road Search results, use broad search terms. In the
above example, a better search term would be simply “main”.
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IntroductionIntroductionIntroductionIntroductionIntroduction
THE CAMEOFM SUITE

CAMEOfm is called a “suite” because it encompasses several different
software applications, all which are “connected” through various
methods, and thus “work together” to produce results. Another common
software suite is Microsoft Office, which also consists of several
software applications, all designed to conduct different operations
which work together to produce results.

The CAMEOfm suite is generally considered to include these four
software programs:

1. CAMEOfm

2. ALOHA

3. MARPLOT

4. LandView

Two other applications commonly associated with CAMEOfm are:

1. RMP-COMP - http://www.epa.gov/ceppo/tools/rmp-comp/comp-
dwn.html

2. A.R.C.H.I.E. - http://hazmat.dot.gov/risk_tools.htm

These two programs model chemical releases similarly to ALOHA,
however RMP-COMP and A.R.C.H.I.E. also produce “blast zone” types of
estimates for explosive and/or flammable substances. For more
information, see the associated websites.

STRUCTURE

CAMEOfm: A Relational Database
CAMEOfm is built on the FileMaker Pro platform. FileMaker Pro is a
“relational database”; therefore, you may consider CAMEOfm a
“relational database”. Another common “relational database” is
Microsoft Access.

In simplistic terms, a “relational database” is a collection of
“spreadsheets”, each containing “data” in “fields” or “cells”. Two common
spreadsheet programs are Microsoft Excel and Lotus 1-2-3.
“Spreadsheets” organize data into rows and columns; each intersect of a
row and a column is called a “cell”.
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CAMEOfm consists of a group of several “spreadsheets” that are
“connected” or “linked” so that information contained in one
spreadsheet can be associated with information from a different
spreadsheet. The spreadsheets are thus “related”, hence the name
“relational database”. The importance to CAMEOfm users will be
explained in the following sections.

The CAMEOfm spreadsheets most commonly utilized are called
“modules”, such as, Facilities, Chemicals in Inventory, Contacts, Special
Locations, etc. You may visualize each CAMEOfm module as a
“spreadsheet” with “rows” and “columns” that intersect at a “cell”. Each
“cell” contains data, whether that be a text paragraph (e.g., RIDS
General Description), a number (e.g., Zip Code or IDLH value), a word or
words (e.g., Facility Name), and so forth.

Each CAMEOfm module (or spreadsheet) is “related” to some other
modules. The figure below depicts which modules are related in
CAMEOfm.

ALOHA: THE AIR DISPERSION MODEL

ALOHA is an “air dispersion model”; it is designed to predict downwind
concentrations of various contaminates, vapors, gases, etc. As such,
ALOHA is a “computational” type of software, and does not “integrate”
with software programs in the same manner as other members of the
CAMEOfm suite. However, it is possible to “copy-and-paste” some
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ALOHA outputs, and to “save” screenshots. Also, ALOHA footprints may
be displayed in ArcView using a NOAA ArcMap Import Tool utility.

MARPLOT: A MAP VIEWER

MARPLOT is a “map viewer” software. It interprets data, such as latitude
and longitude, color, line size, line distance, and symbol type, and
displays this data in “map” format. MARPLOT does allow some “data
management” operations, such as Search, Import/Export, Edit, and Save,
but is not considered a “data management” type of software, such as
CAMEOfm and LandView.

MARPLOT does integrate with Microsoft Excel and Word as well as other
mapping applications, such as ArcView and MapInfo.

LANDVIEW

LandView is another “relational database” software, written in FileMaker
Pro as is CAMEOfm. LandView features three main “spreadsheets”:

1. EPA Regulated Sites

2. U.S. Bureau of the Census Data

3. U.S. Geologic Survey, Geographic Names Information System
(GNIS)

These “spreadsheets” contain information provided by these federal
agencies. In addition, LandView features a number of unique internet-
linked functions.

Since LandView is a “relational database”, it can be integrated with other
spreadsheet applications, and may be used to accommodate some data
management functions. However, for the purposes of the manual, most
“data management” type activities are conducted using CAMEOfm.

DEVELOPMENT OF THE CAMEOFM SUITE

CAMEOfm and ALOHA were specifically designed to assist emergency
personnel to plan for and respond to hazardous chemical releases.
LandView and MARPLOT were initially designed to manage geographic
and census data, and became part of the CAMEOfm suite later.

This does NOT mean the CAMEOfm programs are not useful for a wide
variety of user applications. At its core, CAMEOfm is designed for
management of emergency operations related to chemical incidents,
which explains much of “why” the system works as it does.
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The diagram below illustrates some of the ways CAMEOfm suite
programs interface with each other and with external software
programs.
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Using CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft Office
ProductsProductsProductsProductsProducts
INTRODUCTION

Because CAMEOfm is basically a collection of linked spreadsheets, it is
possible to move data from CAMEOfm to Microsoft Access and Excel via
importing and exporting functions. It is not recommended that all
users utilize these functions!  However, for those who are already
familiar with Access and/or Excel , these can be used in association with
CAMEOfm to conduct a number of useful applications.

Also, you are not limited to using only Microsoft Office applications. For
example, Lotus 1-2-3 can be used to do the same functions as Microsoft
Excel. This manual is not intended to promote Microsoft Office
products in any manner. The examples in this manual use Microsoft
Excel and Microsoft Word simply because they are more commonly used
than other spreadsheet and word processing programs.

EXPORTING CAMEOFM TO MICROSOFT EXCEL PROCESS

Exporting from CAMEOfm

1. Activate CAMEOfm

2. Select the “File” menu

3. Select “Import/Export”

4. Select “Export”

5. Select “Export All CAMEO Data”
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Example CAMEOfm Save Screen

6. Select a “location” using the “Save In:” box

7. Name the file

8. Select the “Save” button

At the specified “Save” location, there will now be a .zip file with the
user-specified “name”.

9. Minimize your CAMEOfm screen

10. Browse the “Save” location

11. Double-click on the saved .zip file

Your screen should look similar (if not exactly) like the example CAMEO
Export Opened .zip File Screen illustrated on the next page.
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Example CAMEO Export Opened .zip File Screen

These 14 files contain ALL the information from your CAMEOfm
program, except the Chemical Library module (which is not exportable).

Unzipping the File*
Depending on your computer
operating system and the particular
zip software, there are several
methods of unzipping this file. You
must unzip the CAMEOfm-exported .zip file and save somewhere on
your computer; recommend you save to a specific folder, perhaps
named “CAMEOfm Exports”.

After the .zip file is unzipped, any or all of these files may be “opened”
using Microsoft Excel, Lotus 1-2-3, etc. Again, there are several methods
of opening the individual files.

CAMEOfm exports in “mer” files (merge files) format. Merge files are
“comma separated value” (.csv) files. Microsoft Excel and other
spreadsheet programs recognize .csv  files.

Note:  Your computer must have
a “zip” program to proceed.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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Here is one method which will open the .mer files in Microsoft Excel:

1. Right-click on any of the unzipped .mer files

2. Select “Rename”

3. Change the file extension from “.mer” to “.csv”

Usually, you will see this message box:

Example Excel Rename Message Box

4. Select “Yes” and proceed

Notice the “file icon” is now an Microsoft Excel file. Double-click on the
new .csv file icon, and it will activate and open in Microsoft Excel.

You now have the correct “format” for importing data to a single
CAMEOfm module using Microsoft Excel. The importing process is
discussed in a later section of this manual.

EXPORTING MARPLOT TO MICROSOFT EXCEL PROCESS

MARPLOT exports in three different formats:

1. MARPLOT Import/Export files (.mie)

2. Simple Point Export (.txt)

3. GENERATE files (for use with ArcInfo software)

A Simple Point Export (.txt) can be opened in Microsoft Excel. A “simple
point” object in MARPLOT is defined as a single intersection of a
Latitude and a Longitude. Thus, many map objects are not generally
expressed as a “simple point” )i.e. Roads, Lakes, City Limits, Zip Code
Areas, Canals, and Railroads).



cameo companion for planners

129

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

However, many MARPLOT objects can be expressed as a “simple point”.
Any MARPLOT object shown as a “symbol” is a simple point object.
Common examples are Facilities, Day Care Sites, Storm Shelters, Fire
Stations, EMS Locations, Hospitals, etc.

MARPLOT allows import/export of simple point object sets using any
spreadsheet-type program, such as Microsoft Excel or Lotus 1-2-3. This
can be an extremely useful tool to enter new locations to MARPLOT.

1. Activate MARPLOT

2. Select any simple point object (usually displayed as a “symbol”)

3. Select the “File/Export” menu

4. Select “MARPLOT Simple Point Format”

Example MARPLOT Export Box

5. Select “Export” button

6. Name and save the file (make sure it saves as a .txt file)
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Example MARPLOT Export Screen

This .txt file can be opened using Microsoft Excel.

1. Activate Microsoft Excel

2. Select the “File/Open” menu

3. Set the “File Type” to “Text” Files
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Example Microsoft Excel “Open File” Box

4. Double-click on the saved export .txt file; your screen will
resemble the example below.

Example Microsoft Excel Open Delimited Data Box
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5. Select “Next”

6. Select “Finish”; your screen will look like the example below.

Example MARPLOT Simple Point Export .txt File Opened in Microsoft
Excel

Notice there are no “column headers”. The column labels would be:
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Example MARPLOT Simple Point Export .txt File Opened in Microsoft
Excel with Column Headings Added

You now have the correct “format” for importing “simple point” files to
MARPLOT. The importing process is discussed in a later section of this
manual.

“COPY-AND-PASTE” FROM CAMEOFM SUITE PROGRAMS TO WORD

PROCESSORS

Standard “copy-and-paste” commands function for all the CAMEOfm
suite programs. In CAMEOfm, the familiar “right-click” mouse
functions are not enabled; use the “Edit” menu for copy-and-paste
commands.
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Entering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfm
SuiteSuiteSuiteSuiteSuite
ENTERING PAPER TIER 2 REPORTS TO TIER 2 SUBMIT

It is quicker and easier to enter “paper” Tier 2 reports to Tier 2 Submit,
then export the record(s) and import to CAMEOfm.*

1. Activate Tier 2 Submit

2. Select the “Start Tier 2 Submit” button

3. Select the “New Facility” hot button

4. Enter information from the form to
the “Address” page

5. Select the “Location and ID” tab;
continue until finished

6. Select the “Contacts” tab

7. Select “Add Contact”

Tier 2 Submit will display a list of all contacts available. To prevent
duplication, you will want to determine if the contact is already in the
list. One method is to simply use the scroll bar to examine the contact
list.*

8. Continue through the State Fields, Certification, and Notes tabs

9. Select the “Chemical Inventory” hot button; continue entering
information to appropriate fields and tabs.

10. Select the “New Chemical in Inventory” hot button and continue,
if more than one chemical needs to be entered

Entering Multiple Facilities
See Data Entry Tips/Duplicate Record Function for Entering Multiple
Facilities below.

Note: Tier 2 Submit is
always in “Edit” mode,
and entered data is
always “Saved” without
any actions.

Note:  When there are hundreds or thousands of contact entries to
examine, you should use the FileMaker “Find” function (see Data Entry Tips
Section below).

○ ○ ○ ○ ○ ○ ○ ○ ○

○

○

○

○

○

○

○

○ ○ ○ ○ ○ ○ ○ ○ ○

○

○
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DATA ENTRY TIPS

FileMaker Find Function
After selecting the “Add Contact” button, the “Pick a Contact” screen
appears and the “Search” menu is disabled. You may use the FileMaker
“Find” function as a search engine at this point.

1. Select the “Browse” button located in the lower left side of the
screen

2. Select “Find” from the pop-up menu; the “Pick a Contact” fields
will appear empty.

3. Enter the desired Contact Name to the appropriate field

4. Hit the “Enter” key on your keyboard

Either a list of contacts with the “search” name or the “No records match
this request” text will appear.

Validate Record Function
After completing data entry for a record, you should ALWAYS check your
work using the “Validate Record” function.

1. Activate the Facilities List screen

2. Select the record you wish to “validate”

3. Select the “Record” menu

4. Select “Validate Record”

Tier 2 Submit examines the record to determine all required fields have
“data”. The validation function CANNOT determine if the data is
“accurate”, but CAN determine if a required field is “blank” or has
incorrectly formatted data.
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If a data field needs to be “fixed”, the following message box will
appear.

Example Tier 2 Submit Failed Validation Prompt

In some cases, you will choose to “Ignore” the “validation error” and
continue. Otherwise, select the “Go To Field” button and the cursor will
be transported to the exact field Tier 2 Submit has determined is in
error.

Duplicate Record Function for Entering Multiple Facilities
Tier 2 Submit features a “special” Duplicate Record function that is
useful when entering multiple facilities from one company. In many
cases, the contacts and chemical information is identical for all
submitted Tier 2 records, and you can accelerate data entry by
“copying” a record and altering only the Facility Name and Address.

1. Set your screen to the Facilities list

2. Highlight the “Facility” you wish to copy

3. Select the “Record” menu

4. Select “Duplicate Record”

The entire record has been copied, including all the Chemical Inventory
and Contact information; change ONLY the information that is different
from the preceding record.
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ENTERING PAPER TIER 2 REPORTS DIRECTLY TO CAMEOFM

Entering Tier 2 paper forms for CAMEOfm is much the same as entering
to Tier 2 Submit, but is usually a more lengthy process due to the
following differences:

1. The “Duplicate Record” function is NOT active in CAMEOfm

2. The “Validate Record” function is NOT active in CAMEOfm

3. The screen layout in CAMEOfm does not mirror the paper forms
as well as Tier 2 Submit does.

MOVING RECORDS FROM TIER 2 SUBMIT TO CAMEOFM

Tier 2 Submit “File” menu offers two “export” functions: “Export” and
“Create Submission”.

EXPORTING FROM TIER 2 SUBMIT FUNCTION

1. Activate Tier 2 Submit

2. Select the “File” menu

3. Select “Import/Export”

4. Select the appropriate “Records to include in Export” option

5. Select “Export Files”

6. Name and save the export file

Create Submission Function
1.  Activate Tier 2 Submit

2. Select the “File” menu

3. Select “Create Submission”

4. Select the appropriate “records to include for submission”
option

5. Select “Start Submission Validation” button

Tier 2 Submit examines the record(s) selected for submission to
determine all required fields have “data”. The validation function
CANNOT determine if the data is “accurate”, but CAN determine if a
required field is “blank”, or has incorrectly formatted data. When
validation finds a “blank” field, the following screen appears.
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Example Tier 2 Submit Failed Validation Report Box

You may select the “View Validation Report” to see what data fields need
to be altered.

After viewing the validation report screen, you may use the “File/Close“
menu to return to the Facility list.

When the selected records “pass” the validation process, you may
proceed to either print a “paper report” or create an export file to
import into CAMEOfm.

6. Select “Create Electronic File”

7. Name and Save the file
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Transferring Data from Tier 2 Submit to CAMEOfm
Tier 2 Submit exports data in a .zip file which can be imported directly
to CAMEOfm. After completing a Tier 2 Submit “export”, perform the
following steps:

1. Activate CAMEOfm

2. Select the “File” menu

3. Select “Import/Export”

4. Select “Import”

5. Select “Import” from the “backup your data” message box

6. Browse to the saved Tier 2 Submit .zip file and double-click

Transferring Data from Tier 2 Submit to Microsoft Access
EPA has a “utility” which transfers records from Tier 2 Submit to
Microsoft Access, and from Microsoft Access to Tier 2 Submit. This is a
free utility, and can be obtained (along with instructions on how to
operate the utility) by request to EPA Headquarters or any of a number
of state EPCRA contacts.

Transferring Data from Tier 2 Submit to Microsoft Excel
Any Tier 2 Submit record(s) which includes lat/long values can be
transferred to MARPLOT using a spreadsheet software (see the
Importing Microsoft Excel to MARPLOT section).

Adding/Entering CAMEOfm Special Locations/Routes/
Resources to CAMEOfm
There is no “customized” software to enter records to the remaining
CAMEOfm modules. Data entry is achieved by either “direct” or “manual”
entry, or by utilizing a “spreadsheet import” method (see Importing
from Spreadsheets to CAMEOfm section).*

Note: The critical decision in CAMEOfm data
entry is determining which module should house
the desired record. Before entering ANY data, you
should review the CAMEOfm modules to determine
which offers the most appropriate data fields for
the record information.

○ ○ ○ ○ ○ ○ ○ ○ ○
○

○

○

○

○

○

○

○
○ ○ ○
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Linking CAMEOfm Special Locations/Routes/Resources to
MARPLOT
You may “enter and link” CAMEOfm records to MARPLOT objects
simultaneously. After entering a CAMEOfm record:

1. Activate MARPLOT

2. Locate the record site in MARPLOT

3. Open or create the appropriate MARPLOT layer (“List” menu)

4. Use the cursor to click on the record site

5. Set the “Object Settings” as desired (do not enter an object
name)

6. Make sure the object in “selected” (surrounded by four red
squares)

7. Select the “Sharing/CAMEOfm/Link Object” menu

8. Make sure the appropriate CAMEOfm record is active or
highlighted

9. Select the “Link” menu (in CAMEOfm)

10. Select “Link this record”

To determine if the link process was successful:

1. Make sure the CAMEOfm record is active

2. Select the “Sharing/MARPLOT/Show This Record” menu

If the link is active, the MARPLOT screen will be resized to window width
of 0.60 miles with the object centered.

USING “COPY-AND-PASTE” TO ENTER DATA TO CAMEOFM

MODULES

You may “copy-and-paste” to CAMEOfm data fields. However, the “right-
click” function is not active in CAMEOfm; use the “Edit” menu for “copy-
and-paste” commands.

Entering Site Plans and Other “Image” Files to CAMEOfm
CAMEOfm has a folder named SITE PLANS specifically designed to store
image files: .jpg, .gif, .tif, and .bmp. Typically, this is used to house
facility site plans, maps, diagrams, digital photos, and aerial photos.

CAMEOfm Site Plans is a viewer file only; editing of the images must be
done outside the confines of CAMEOfm and then saved to the Site Plans
folder.
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Basic steps for attaching site plans are as follows:

1. Save the image in one of the acceptable formats

2. Save OR copy the image to the Site Plans folder in CAMEOfm;
remember the file name and extension, you will need that
information to type into a text box later

3. Open the facility record you wish to link with the image

4. Select the “Site Plans” tab

5. Choose “Edit” from the module toolbar

6.  Follow the instructions on the screen*

Editing CAMEOfm Site Plans
Almost all computers feature some type of “photo editor” software
which may be used to alter or add information to CAMEOfm image files.

1. Use the Explore function to open the CAMEOfm Site Plans folder

2. Double-click on the desired image file

Usually, this will open the selected image file in whatever photo
software is present on your computer. You may then alter the photo as
desired, and “save” back to the CAMEOfm Site Plans folder. The changes
will now display in CAMEOfm.

INSERTING IMAGE FILES INTO MARPLOT
MARPLOT will display .bmp format image files. To place any .bmp file in
MARPLOT:

1. Activate MARPLOT

2. Open layer (or create the desired layer) (“List” menu)

3. Select the “Edit” menu

4. Select “Insert Picture Object”

5. Select “Use Existing Map”

Note:  The EXACT image file name and extension
MUST be entered. You may “copy-and-paste” the
filename with extension from the Site Plans folder
into the CAMEOfm edit screen using the "Edit"
menu commands.

○ ○ ○ ○ ○ ○ ○ ○ ○

○

○

○

○

○
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6. Select “File”

7. Browse to the image file location and double-click

8. Set Object Settings as desired (suggest setting to “User’s Map”)

9. Use  the “Geo-Reference” function (discussed in a later section)
if desired

10. Select “OK”

The image file should now be displayed on the MARPLOT screen.

Moving the Inserted Picture to the Bottom of the Layer List
MARPLOT treats “picture files” as one solid object, thus the inserted
picture may obscure other layer data. It is usually best to use the Layer
List to “move” the layer containing the inserted image to the “bottom” of
the Layer display list.

1. Open the MARPLOT “List/Layer List”

2. Highlight the layer containing the inserted picture object

3. Select “Draw Order” at the top left of the “Layer List” box

4. Select the “Move” button

5. Select “Bottom”

6. Select “OK”

ADDING NEW LOCATIONS TO MARPLOT
Adding a Single Location

1. Activate MARPLOT

2. Select “List/Layer List” menu

3. Open or create the appropriate layer

4. Select “OK”

5. Use the draw tools to create the object

6. Set Object Settings to either “User’s Map” or “CAMEO Map”

7. Select “OK”
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Importing Multiple “Simple Point” Locations using Microsoft
Excel*

1. Create an Microsoft Excel file as shown below.

Example MARPLOT Simple Point Export .txt file Opened in Microsoft
Excel with Headers Added

2. Enter data to the appropriate Microsoft Excel columns;
remember to use “negative” values for Longitude.

The MARPLOT Layer Name column can contain multiple layer names. It
is NOT necessary to repeat this process for multiple MARPLOT layer
entries; it can be performed with one Microsoft Excel file. What layer
name is entered in MARPLOT will be “created” or “used” when imported.

3. Make sure the MARPLOT Map name is either “User’s Map” or
“CAMEO Map”.

Symbol name and color are not critical; those can be changed after
importing.

Note:  Review Exporting MARPLOT to Microsoft Excel section before proceeding.

○ ○ ○

○

○
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The MARPLOT ID Number is the “critical field”.  The ID numbers
MUST BE UNIQUE!

A discussion of MARPLOT ID numbers is found on page 22 of the
MARPLOT Technical Documentation book available at http://
response.restoration.noaa.gov/cameo/pdf/MARPLOTTechDoc.pdf.

Here is one idea for creating MARPLOT ID numbers:

1. Activate EXCEL

Begin the ID number with the characters “BD”, followed by the “Layer
Name”, followed by zeros  and ending with the number  “1” to make a
20-character entry. Example: BD_CityHydrants00001

This is a 20-character ID that is unlikely to be “duplicated” by a random
MARPLOT ID assignment.  The remaining ID numbers can be created
using the Microsoft Excel Edit/Fill/Series/Autofill function.

2. Highlight Column H from cell 1 to last data row.

Example Excel Screen Ready to Autofill MARPLOT ID Numbers

3. Select the “Edit/Fill/Series” menu

4. Set to “Autofill”
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Example Excel Autofill Function Screen

5. Select OK

Example Excel Screen with MARPLOT IDs using Autofill
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Each ID number is now “unique”. When finished entering data, delete the
1st row of header names; MARPLOT will not import files with the header
names.

6. Save as a .txt file.

7. Close Excel*

IMPORTING .TXT FILES TO MARPLOT
1. Activate MARPLOT

2. Select the “File/Import” menu

3. Set File Type to “.txt”

4. Browse to the desired .txt file

5. Select the “Open” button

Example Import .txt File to MARPLOT Screen

The new locations should now display in MARPLOT.

Note: Make sure to delete the “Headers” row
before attempting to import the .txt file to
MARPLOT. MARPLOT will recognize ONLY
rows that begin with a longitude value.
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Converting ArcView Shapefiles to MARPLOT

The Shp2mie.exe Utility
A utility to “convert” ArcView .shp files to MARPLOT .mie files is found in
the LandView 5 folder.

1. Right-click on the “Start” button

2. Select “Explore”

3. Click on the “lv5” folder (usually found on your c: drive)

4. Scroll down on the right side of the explore window;  (the
shp2mie.exe icon is blue and red balls inside a yellow square)

To operate the shp2mie.exe, you will need to have a .shp file and its
associated .dbf file in a folder on your computer. Further steps to
convert the .shp file may require some knowledge of the ArcView
software.

Example Shp2mie.exe Shown from Explore Screen
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IMPORTING ARCVIEW “SIMPLE POINT” OBJECTS INTO MARPLOT
USING MICROSOFT EXCEL

For “simple point” objects, it is possible to output ArcView points as an
Microsoft Excel file containing Lat/Long and Object Name. You can
import the information to MARPLOT using the “Importing multiple
simple point locations using Microsoft Excel” process explained in the
preceding section.

You may then import the additional information contained in the .shp
file to CAMEOfm using the spreadsheet methods explained in previous
sections.

IMPORTING LAT/LONG SPREADSHEETS INTO LANDVIEW USING

MICROSOFT EXCEL

It is possible to import lat/long spreadsheets directly to LandView. For
some types of data sets, this could be a preferred option.

1.  Activate LandView

2. Select the “System” menu

3. Select “User Files”

Instructions on importing to the LandView User Files can be obtained by
selecting the “Help” button.

ADDING INFORMATION TO ALOHA
Adding Locations to ALOHA

1. Activate ALOHA

2. Select “Site Data” menu

3. Select “Location”

4. Select “Add”

5. Enter Name, Elevation, Lat/Long, and State

6. Select “”OK””

Adding New Chemicals to ALOHA
The ALOHA Chemical List features mainly “pure” chemicals, along with
five “solution” substances. You are free to add more chemicals to the
list, provided sufficient chemical  property information can be obtained.
In many cases, facilities can provide the chemical properties data
necessary to enter additional “mixture” and/or “solution” substances.
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To add a chemical to ALOHA:

1. Obtain Chemical Property Data

2. Activate ALOHA

3. Select “Setup” menu

4. Select “Chemical”

5. Select “Add”

6. Enter data to appropriate fields

MODIFYING/EDITING CHEMICAL PROPERTIES IN ALOHA
You may “modify” or “alter” the ALOHA Chemical List. While it is NOT
recommended to alter the chemical property data in ALOHA, you may
wish to set the Default LOC values. For example, LOC values for several
chemicals is set to AEGL as default, you may use the Modify function to
set those to ERPG, IDLH, or other user-selected LOC values.
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*Note:  You may alter “related” records from the associated module; i.e. selecting
a record from the Facilities module allows editing of the related Contacts, Chemicals
in Inventory, Phones, Map Data, etc.
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○

○

ALTERING/EDITING DATA

Editing CAMEOfm Records

A Single Record

1. Open the desired CAMEOfm module

2. Find and select the desired record

3. Select the “Edit” hot button*

FileMaker “Find” Function for CAMEOfm: Another “Search” option
CAMEOfm features two types of search functions. The “Search” menu
with the Basic Search and Advanced Search answers most user search
needs.

However, when CAMEOfm is in “Edit” mode, the “Search” menu is
disabled. In those cases, the FileMaker “Find” function is valuable.

The FileMaker “Find” function is found in the lower left corner of your
screen. Typically, the function button is set to “Browse”. When “selected”
(using your mouse) a drop-down list arrow is displayed.

To use the FileMaker “Find”:

1. Use your mouse to click on the “Browse” button. A drop-down
list will appear listing the following: “Browse”, “Find”, and
“Preview”

2. Set the button to “Find”. A screen with blank fields will appear.

3. Enter your search criteria to the appropriate box and hit the
“Enter” key from you keyboard.

FileMaker will conduct a search based on your input criteria and return
a “Found Set”. This same “Find” function works for Tier 2 Submit as well.
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Multiple Records using Microsoft Excel
A previous section of this book discussed a method for exporting
CAMEOfm data and “opening” it in Microsoft Excel. This can be a useful
tool for multiple record edits. Here is an example of using this method
to edit a dataset:

Example: Suppose there are a number of “propane” records in your
Chemicals In Inventory module that were incorrectly assigned as “EHS”
substances. Of course, you could use the “single record” method to
correct each “propane” record individually. As an alternative, you might:

1. Conduct a search in the Facilities module for all “propane”
records

2. Use the “File/Export” menu to export the Found Set

3. Unzip the exported file

4. Change the “ChemicalsInInventory.mer” file to
“ChemicalsInInventory .csv”

5. Open the .csv file using Microsoft Excel

The Microsoft Excel file should contain ONLY records including the word
“propane” in the name. Of course, there may be some entries that
include the word “propane” as part of their chemical name.

Notice in the example screenshot that some of the CiEHSChemical
column entries are “T” (for True) while others are “F” (for False)
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Example ChemicalsInInventory.csv File Opened in Microsoft Excel

6. Locate the “CiEHSChemical” column in Microsoft Excel

7. Use Microsoft Excel functions to change all “CiEHSChemical”
column entries to “F”
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Example ChemicalsInInventory.csv File Opened in Microsoft Excel
with Alterations

8. Save the altered Microsoft Excel file as
“ChemicalsInInventory.csv”

9. Close Microsoft Excel

Now, you can import the altered file back to CAMEOfm and your
changes will be active.

10. Rename “ChemicalsInInventory.csv” to
“ChemicalsInInventory.mer”

11. Insert the new “ChemicalsInInventory.mer” back into the original
exported CAMEOfm .zip file.

12. Use the “File/Import” menu to import the .zip file containing the
altered “ChemicalsInInventory.mer” back to CAMEOfm
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Note:  Be careful! If these MARPLOT objects are “linked” to CAMEOfm records,
changing the object layer or map will remove the CAMEOfm link. These MARPLOT
objects will then have to be “re-linked” to the corresponding CAMEOfm records.

Note: If the layer and map settings are “grayed out”, it means the layer
containing this object is “locked”. You will need to “unlock” the layer before editing
the specific object.

You may change the layer and map setting directly from the “Objects” menu.
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○

○

ASSIGNING MARPLOT OBJECTS TO DIFFERENT LAYERS AND MAPS

A Single Object

1. Activate MARPLOT

2. Unlock both the layer containing the object and the layer to
which you wish to “move” the object

3. Select the desired object

4. Select the “Objects/Object Settings” menu

5. Set the layer and map as desired*

Multiple Objects
The same process can be used to “move” multiple objects to different
layers and maps. Objects to be moved may be “selected” using the
“Shift-click” function, or by using a “Search/Show All on Map” function.

Multiple Objects using Microsoft Excel
A previous section of this book discussed a method for exporting
MARPLOT simple point objects and “opening” them in Microsoft Excel.
This can be a useful tool for multiple record edits.

1. Export the desired objects to a .txt file

2. Open the .txt file in Microsoft Excel

3. Use Microsoft Excel functions to set desired layer and map
names

4. Save the file and import back to MARPLOT*

Renaming MARPLOT Objects
Renaming MARPLOT objects uses the same processes as assigning to
different layers and/or maps.
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Linking DataLinking DataLinking DataLinking DataLinking Data

LINKING MARPLOT OBJECTS TO CAMEOFM RECORDS

A Single Object to Record: Sharing Menu

1. Activate MARPLOT

2. Select the object to be linked

3. Select the “Sharing” menu

4. Select “CAMEOfm” and “Link Object”; this will activate CAMEOfm

5. Open or select the appropriate CAMEOfm record

6. Select the “Link” menu

7. Select “Link this record”

To determine if the link was successful:

8. Select the “Sharing” menu in CAMEOfm

9. Select “MARPLOT” and “Show on Map”

If the link is operational, the screen should activate MARPLOT, and
display the linked object centered with a scale of 0.08 window width.
Depending on your layer settings, the object should now display a name
taken from the CAMEOfm record.

Multiple Objects and Records: MapData.CAM file

Viewing the MapData.CAM file in CAMEOfm

1. Activate CAMEOfm

2. Open the “Window” menu

3. Select “MapData.CAM”
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Note: If MapData.CAM is not present under the Window list, it is not “open”. To
open, select any linked CAMEOfm record and do a Sharing/Show on Map
command.
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Example CAMEOfm MapData.CAM Window screen*

4. Select “View Data”
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Example CAMEOfm MapData.CAM View Data Screen

This is the file that links CAMEOfm records to MARPLOT objects. Notice
it is a spreadsheet containing CAMEOfm IDs, MARPLOT IDs, and the
MARPLOT layer and map names.

The MapData.CAM window can be closed by either of the following
steps:

M Select “File/Close”

M Select “Window/Navigator”

Opening MapData.CAM using Microsoft Excel
1. Export a single or group of CAMEOfm Facilities, Special

Locations, or Resources

2. Unzip the resulting .zip export file; a “MapData.mer” file should
be found along with the other unzipped files

3. Change “MapData.mer” to “MapData.csv”

4. Open in Microsoft Excel
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Example MapData.csv File Opened in Microsoft Excel

The 1st column, “RecordKey”, is a CAMEOfm ID to link the CAMEOfm and
MARPLOT ID numbers. You will “create” the RecordKey number,
formatted as beginning with “MD” and containing 18 other characters.

The 2nd column, “ParentRecordID”, is the CAMEOfm ID number taken
from any of the CAMEOfm modules that can be linked to MARPLOT (i.e.,
Facilities, Special Locations, Routes, Resources, and Incidents). These
IDs can be “copy-and-pasted” from the associated CAMEOfm exported
.mer files.

The 3rd, 4th, and 5th columns are for MARPLOT layer, map, and ID data.
These can be “copy-and-pasted” from a MARPLOT Simple Point Export
.txt file.

5. Use the “cut-and-paste” and other Microsoft Excel functions to
insert data to be linked.

6. Save the file as “MapData.csv”

7. Close Microsoft Excel

8. Change the file name to “MapData.mer”
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9. Zip the file, or copy back to original exported CAMEOfm export
.zip file

10. Import .zip file back to CAMEOfm

LINKING CAMEOFM SITE PLANS TO CAMEOFM RECORDS

First, the desired Site Plan(s) must be present in the CAMEOfm Site Plans
folder. You may “paste” to the Site Plans folder using “Explore”
functions.

1. Right-click on the “Start” button from your bottom taskbar

2. Select “Explore”

3. Find the CAMEOfm folder in the left side of your Explore screen

4. Select the “+” sign next to the CAMEOfm folder to “expand” the
folder

5. The Site Plans folder should be visible

6. Paste desired Site Plan(s) into the folder

Example CAMEOfm Site Plans Folder Opened in Explore
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A Single Site Plan: Edit Function
1. Activate CAMEOfm

2. Select the record to be linked to a site plan

3. Select the “Site Plans folder” tab

4. Select the "Edit" hot button

5. Follow the instructions; remember to include the filename
extension

6. Continue to “add” site plan names for the selected record until
finished

7. Select “Save Changes”

Example CAMEOfm Edit Site Plan Screen
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Multiple Site Plans: SiteDataLink.CAM File

Viewing the SitePlanLink.CAM file in CAMEOfm

1. Activate CAMEOfm

2. Open the “Window” menu

3. Select “SitePlanLink.CAM”

Example CAMEOfm SitePlanLink.CAM File

This is the file that links CAMEOfm Records to Site Plans. Notice it is a
spreadsheet containing only CAMEOfm IDs and site plan names.

 The SitePlanLink.CAM window can be closed by either of the following
steps:

M Select “File/Close”

M Select “Window/Navigator”
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OPENING SITEPLANLINK.CAM USING MICROSOFT EXCEL

1. Export a single or group of CAMEOfm Facilities or Special
Locations

2. Unzip the resulting .zip export file

3. A SitePlanLink.mer file should be found along with the other
unzipped files

4. Change “SitePlanLink.mer” to “SitePlanLink.csv”

5. Open in Microsoft Excel

Example CAMEOfm SitePlanLink.CAM file Opened in Microsoft Excel
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6. Use “cut-and-paste” and other Microsoft Excel functions to insert
data to be linked.

7. Create correctly formatted “RecordKey” ID numbers for each row

8. Save the file as “SitePlanLink.csv”

9. Close Microsoft Excel

10. Change the file name to “SitePlanLink.mer”

11. Zip the file, or copy back to original exported CAMEOfm export
.zip file

12. Import .zip file back to CAMEOfm
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Getting Data OutGetting Data OutGetting Data OutGetting Data OutGetting Data Out

MAKING REPORTS IN CAMEOFM

CAMEOfm Make Report Function

1. Activate CAMEOfm

2. Open the appropriate CAMEOfm module

3. Select the desired record(s)

4. Select the “File/Make Report” menu

5. Select data to include in report

Copy-and-Paste to Microsoft Word

1. Perform Steps 1 – 5 from above

2. Highlight text you wish to paste into Microsoft Word

3. Select the "Edit" menu

4. Select “Copy”

5. Paste into Microsoft Word

CAMEOfm Reports using Microsoft Excel

1. Activate CAMEOfm

2. Open the appropriate CAMEOfm module

3. Select the desired record(s)

4. Select the “File/Import/Export” menu

5. Export data to .zip file

6. Minimize or close CAMEOfm

7. Unzip the .zip export file

8. Select the .mer file(s) containing desired report information

9. Change “.mer” file extension(s) to “.csv”

10. Open in Microsoft Excel and create the report
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Example: Creating an “Owner” Mailing List

1. Activate CAMEOfm

2. Select the “File/Import/Export” menu

3. “Export All CAMEO Data”

4. Unzip the exported file to a folder

5. Change the “Contacts.mer” file to “Contacts.csv”

6. Open “Contacts.csv” in Microsoft Excel

7. Delete all contacts that are not “owners”

8. Delete all Microsoft Excel Columns except those containing
name and address data

9. Use Microsoft Word “Mail Merge” function to create and print
the list of names and addresses; these could be printed to
labels or to envelopes, depending on your printer settings

SAVING MARPLOT SCREENS AS A BITMAP

1. Select the "File" menu

2. Select “Save as picture”
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Example MARPLOT Save as a Picture screen

The MARPLOT screenshot is now an “image” file. The .bmp file may be
converted to .jpg or .gif using any photo editing software (i.e., Paint,
PhotoShop, etc.).

Copy-and-Paste into other Software Programs
There are several ways to save MARPLOT screenshots to other software
applications. Here are two methods:

Method 1

1. Save the screenshot as a .bmp file following above instruction

2. Insert or paste the .bmp file to the desired software
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Method 2

1. Activate MARPLOT

2. Set the screen layers and scale as you wish to have it “saved”

3. Select “ALT-Print Screen” from your computer keyboard

4. Activate the software where you wish to paste the picture

5. Select “CTRL-V” from your computer keyboard

There are other methods to move the MARPLOT screen to another
software. Some of the same processes will also move ALOHA and
CAMEOfm screens to other programs.

Saving MARPLOT Screenshots to CAMEOfm Site Plans
1. Save the MARPLOT screen as a .bmp file to the CAMEOfm Site

Plans folder

2. You may now “link” the MARPLOT .bmp file to a CAMEOfm
Facility or Special Location Record (see Linking CAMEOfm Site
Plans to CAMEOfm Records)

SAVING ALOHA INFORMATION

Displaying Multiple ALOHA Plumes on MARPLOT Maps
Although ALOHA 5.3 can produce three footprints simultaneously, those
footprints differ ONLY by Level of Concern values. You may have need
to display multiple ALOHA footprints for differing Wind Direction, Wind
Speed, Source Options, Amount Released, etc.

To display such differing ALOHA footprints, you may use the MARPLOT
Layer and Draw Tool functions to “trace” the footprints, thus creating
new MARPLOT objects. Once the object is created, you may “save” or
“print” the MARPLOT screens as discussed in above sections.*

Note: Recommend use of the “Polygon” tool to “draw” the ALOHA various
footprints on MARPLOT.
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Saving ALOHA as .alo Files
The ALOHA “File/Save” or “Save As” menu allows you to save the current
ALOHA information as a .alo file. .alo files can be opened back to
ALOHA in two formats: Response Mode or Planning Mode. Use the
ALOHA “Help” menu to determine which mode is best for the situation.

Copy-and-Paste into other Software Programs
The five ALOHA output screens can be transferred to word-type
programs using “copy-and-paste” functions.

Copying to Microsoft Word

1. Activate ALOHA

2. Activate the output screen to be copied (Footprint,
Concentration, Dose, or Source Strength)

3. Select the “Edit/Copy” menu

4. Paste into Microsoft Word

The Text Summary information may also be pasted in Microsoft Word,
but the process is slightly different. Use you mouse to “highlight” the
text you wish to copy, then use the "Edit" menu or right-click to “copy-
and-paste” the selected text.

Another “copy-and-paste” option is to use the “Alt/Print Screen” and
“CTRL-V” keyboard functions. You can transfer all five ALOHA output
screens simultaneously using this method.
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Sharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm Suite
UsersUsersUsersUsersUsers

IMPORTING/EXPORTING CAMEOFM DATA

Exporting All CAMEOfm Data
1. Activate CAMEOfm

2. Select "File" menu

3. Select “Import/Export”, and then select “Export”

4. Select “Export All CAMEO Data”

This exports all CAMEOfm records and associated MARPLOT and Site
Plan Links. It does not export the actual Site Plan image files.

Exporting Selected CAMEOfm Data
1. Activate the CAMEOfm module from which data will be exported

2. Conduct a search to select the record to include in the export

3. Select "File" menu

4. Select “Import/Export”, and then select “Export”

IMPORTING/EXPORTING CAMEOFM SITE PLANS

CAMEOfm Site Plans are image files located in the Site Plans folder. To
share them with another user, the actual image files must be
transferred.

1. Right-click on the “Start” button from the bottom taskbar

2. Select “Explore”

3. Find and open the CAMEOfm Site Plans folder

4. Select the image files to be transferred

5. “Copy-and-paste” to a folder or external storage device

6. Paste into the CAMEOfm Site Plans folder on the target
computer
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IMPORTING/EXPORTING MARPLOT DATA

MARPLOT data may be exported in threedifferent formats:

M MARPLOT Import/Export (.mie) files

M Simple Point Export (.txt) files

M ArcInfo GENERATE files*

You may use either .mie or .txt files to export “single point” objects. Use
GENERATE files to transfer MARPLOT object information to ArcInfo
systems.

IMPORTING/EXPORTING LINKED CAMEOFM AND MARPLOT
DATA

If your data contains “linked” CAMEOfm records and MARPLOT objects,
you will need to perform two exports and two imports to transfer the
data, plus copy the associated Site Plan image files as a separate
operation.

One method of exporting a “linked” CAMEOfm – MARPLOT dataset is:

1. Activate CAMEOfm

2. Activate the module containing the records to be transferred

3. Select the records to be transferred using a search

4. Export the “Found Set” to a CAMEOfm .zip file

5. Return to the “Found Set” list in CAMEOfm

6. Select the “Sharing” menu

7. Select “MARPLOT/Show all on Map”; the linked MARPLOT objects
should display as “selected”.

8. Select the "File" menu

9. Select “Export”

10. Export the “selected objects” to a .mie file

The two export files can now be imported to a different set of CAMEOfm
and MARPLOT software. After importing the CAMEOfm record to
MARPLOT, objects links should be preserved.

Note: Generally, it is recommended to use .mie files for MARPLOT to MARPLOT
data transfers.
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Data Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data Recovery

CAMEOFM DATA BACKUP AND RECOVERY

To backup all CAMEOfm data, simply export all data:

1. Activate CAMEOfm

2. Select the "File" menu

3. Select “Import/Export”

4. Select “Export”

5. Select “Export All CAMEO data”

The resulting .zip file is your data backup.

DATA RECOVERY

Sometimes you will see a message in CAMEOfm indicating the “file is
damaged and must be recovered”.

One suggested method is to use the full version of FileMaker Pro. An
alternative is to use the runtime version of FileMaker that is operating
CAMEOfm.

Using FileMaker Pro 5.0 Recover Function

1. Open FileMaker Pro

2. Select “Cancel” from the opening screen

3. Select the "File" menu

4. Select “Recover”

5. Set recover browse box to “All Files”
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Example FileMaker Pro 5.0 Recover Screen

6. Locate the “damaged” file

Example of “Damaged” File in Contacts.CAM

7. Highlight and open the damaged file
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Example Contacts Recovered.CAM Screen

8. FileMaker Pro automatically creates a “name” that includes the
word “recovered”

9. Select “Save”

10. Select “OK”

This process should add a new “______ recovered.CAM” file to your
CAMEOfm folder.

If you recovered the file while CAMEOfm was “open”, you should now be
returned to active CAMEOfm screen. If you are not returned immediately
to CAMEOfm, use your Start menu to Activate CAMEOfm.

11. If the “cannot find _____.CAM” message appears, use the
resulting browse box to select the newly created “______
recovered.CAM” file.

12. Immediately export all CAMEOfm data!

This version of CAMEOfm has been compromised. It is strongly
recommended that you discontinue use of it immediately. Install a
new version of CAMEOfm and import the saved data.
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Note:  Be careful! Make sure you have
saved all your CAMEOfm data BEFORE
installing a new version. Consider
making at least two .zip backup files
prior to performing the installation.

○
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1. Install a “new” copy of CAMEOfm

2. Delete the Prince William County records

3. Import the saved data .zip file to the new CAMEOfm.

4. Uninstall the old CAMEOfm program, if necessary (The “old”
version may have been “overwritten” during installation of “new”
version).*

Using the FileMaker Pro Developer Edition
Data may be recovered without purchasing the full FileMaker Pro
version 5.0, using CAMEOfm only.

5. Close CAMEOfm, and restart while holding the Control (CTRL)
and Shift keys. CAMEOfm will open in “recover” mode.

Instructions on recovering your data using this method are found at:
http://www.filemaker.com/ti/104177.html
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Note: Depending on the version of Windows you are
using - Windows 95 vs. Windows 98 vs. Windows XP -
you should check to see if the items inside these
subdirectories are locked, once you moved them into
your new LandView 5 subdirectory. To check to see if
they are locked - select all of them (Ctrl A) and then
right lick on them - check the properties - if they are
locked - please uncheck the locked box so they are
unlocked.
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Adding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to Your Hardour Hardour Hardour Hardour Hard
DriveDriveDriveDriveDrive
 Please read the entire process before you begin.

1. Install LandView 5 - it will install into your C: drive - you can
move it to another drive, after you install it, if you want to. (This
entire process will use approx. 220 mb of space)

2. Open the Maps subdirectory on the CD. Open the newly created
LV5 subdirectory on your hard drive. You want them both open -
resize the windows so they are next to each other.

3. Copy the Census, EPA and USGS GNIS and LV5 subdirectories
from the CD into the LandView 5 subdirectory. (Yes, you will
have a LV5 subdirectory inside the LV5 subdirectory).

4. Back on the CD - open the maps subdirectory then open the
tiger subdirectory then open the OK subdirectory. Select all of
the counties you want - Ctrl A will select all of them). Please
make sure that all of the counties are moved to the same level
that the MARPLOT application is at. This is very important. If
you do not do this MARPLOT will not "see" the maps.*
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Note: This process was provided by Tim Wixom of
Steuben County,  New York Emergency Management
Office.

○

○

○

5. There are three small files left on the CD that we have not
moved - please copy the Marplot.glx, Marplot.lnx and
Marplot.vnx file into the newly created LV5 subdirectory on your
hard drive. (Make sure you unlock them after you move them .)

6. Locate the Marplot.vnx file in your LV5 subdirectory on your
hard drive and open it with Notepad or another editing
program. The first line of code is:

7.  LV5 -  You need to change that to match the drive on your
computer (C:/LV5). This is only an example - if you hard drive is
labeled Fred it needs to be Fred:/LV5. Before you launch the
LandView 5 application - reboot your computer.*
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Importing Lat/Long Spreadsheets to LandView
It is possible to import spreadsheet data directly to LandView. This is
particularly useful when the data includes a Lat/Long value, because the
associated data is automatically “mapped and linked”.

To access the LandView “import” engine:

1. Activate LandView

2. Select the “System” menu

3. Select “User Files”

Example LandView User Files Screen

Instructions on how to import to the user files are found by selecting
the “Help” button.
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Note: The following is reprinted from NOAA webpage: http://
response.restoration.noaa.gov/cameo/dll8.html

○
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Displaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcView*****

ARCMAP ALOHA IMPORT TOOL

You can add aloha_8.dll to your ArcMap 8.x or 9.x toolbar to enable the
import of ALOHA footprint files. This version was released on July 23,
2004.

Downloading the Import Tool
If your browser supports FTP downloading (most current browsers do),
download aloha8dll.zip (i.e., the compressed version of aloha_8.dll) by
clicking the link below. Otherwise, you can use an FTP utility.

1. Download aloha8dll.zip (48K); the file is in zipped (compressed)
format, so that it can be downloaded from the internet. It is a
self-extracting zip file, so look for the file "aloha_8.dll". (Your
computer may display a message that it is unable to open the
file because it does not know what application created it. You
can disregard this message and continue with the next step.)
Download Problems? Check our troubleshooting page.

2. Save the uncompressed file in any section of your hard drive.

Installing the Import Tool
After you have saved the uncompressed file, "aloha_8.dll", in any section
of your hard drive ...

1. Launch ArcMap

2. Right-click on the ArcMap toolbar and scroll down to
Customize… (or choose the Customize… option under the Tools
menu)

3. Select the “Commands” tab on the Customize window.

4. Click the Add from file… button. Navigate to the aloha_8.dll file
on your hard drive. (If you don't see the file, your browser may
not have automatically unzipped the compressed version. Try
using Stuffit Expander.) Select the file and click Open to add the
Aloha Import Tool to your available tools. Click OK.
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5. In the scrollable list on the left side of the Customize… window,
highlight ArcObjectTools. To the right you should see the Aloha
Footprint Extension command.

6. Click and drag the hula girl icon onto your standard toolbar.
Release the mouse button when your cursor becomes a vertical
bar. (You need to release the mouse button at or before the last
icon on your toolbar.)

7. Exit the Customize… window. You are now ready to use the
Aloha Footprint Extension!

8. To remove the Aloha icon from your toolbar, open the
Customize… window and drag the icon off the toolbar.

Using the Import Tool
When the footprint option is chosen from ALOHA, a file entitled
alo_ftp.pas is created and placed in the ALOHA directory. This file will
be deleted when ALOHA is shut down, so it is best to rename the file in
case you want to import the footprint into ArcMap after ALOHA is off. Be
sure, however, to retain the .pas suffix so ArcMap will recognize the file
as an ALOHA footprint.

To use the ArcMap Tool, simply click on the hula girl icon. You will be
guided through the import process. You will need to provide the source
site of the release, either in decimal degrees or degrees, minutes, and
seconds. The geodatabase that is created will have a defined coordinate
system (geographic coordinates, WGS-84). This allows ArcMap to
reproject the footprint layers if you have other data layers in a different,
defined coordinate system.

You will also need to navigate to the ALOHA footprint .pas file and can
specify an alternate name for the geodatabase (the default will be the
name of the chemical released).

The mapped output will include a layer for each level of concern
specified in the ALOHA .pas file. The layers will be named with these
levels of concern. In addition, a balloon callout box containing the
parameters of the spill and other relevant information is displayed. This
box and the red dot showing the release site are graphic elements and
may be moved or deleted using the graphic selection too.

With the aid of this tool, you will be able to view and query the ALOHA
footprint output with other data layers available for your ArcMap
session.
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Accessing TAccessing TAccessing TAccessing TAccessing TerraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos and
TTTTTopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandView
LandView features a direct connection between the USGS Geographic
Names Information System records (GNIS) and the USGS TerraServer web
pages found on the internet.

The connection is accessed via the LandView USGS “Web Link” button,
only if the computer in use is connected to the internet.

1. Activate LandView

2. Open the USGS GNIS database

3. Select the “View as List” button

Example LandView GNIS list screen

All of the thousands of GNIS records are directly connected to the
TerraServer webpage.

4. Select any GNIS record

5. Select the “Web Link” button
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Example TerraServer Screen Following a LandView Web Link Request

Aerial photos are found by selecting the “Digital Orthophoto
Quadrangle (DOQ)” link.
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Example TerraServer Aerial Photo

Topographic maps are accessed by TopoZone.com or the digital raster
files.
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Example TopoZone.com Map

Example Raster Map



○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

186

INSERTING TERRASERVER AERIAL PHOTOS AND TOPOGRAPHIC MAPS

INTO MARPLOT

Saving the TerraServer Image to your Computer
1. Activate the TerraServer webpage

2. Select the image you wish to display in MARPLOT

3. Right-click on the image

4. Select “Save Picture As”

5. Make sure to save the TerraServer image as a “bitmap” or
“.bmp” file

MARPLOT only displays .bmp files. It will NOT display .jpg or .gif files.

MARPLOT Simple Insert
1. Activate MARPLOT

2. Set map display an area slightly larger than image file to be
inserted

3. Create or open layer

4. Select "Edit" menu

5. Select “Insert Picture Object”

6. Select “Use Existing Map” and “File”

7. “Browse and Open” the saved TerraServer image file
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Example Inserted Picture Object Settings box

At this point, the image may be displayed in MARPLOT by selecting “OK”
or you may select the Geo-Reference option to more accurately locate
the image on the map.

MARPLOT Geo-Reference
Geo-Reference function allows you to specify two Lat/Long points on the
image file. MARPLOT then positions the image on its map based on
those Lat/Long values.



○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

188

Example MARPLOT Geo-Reference Picture screen

For instructions on Geo-Referencing, select the “Help” from the Geo-
Reference Picture screen.

SAVING AERIAL PHOTOS TO CAMEOFM SITE PLANS

TerraServer picture files may be saved to CAMEOfm Site Plans folder and
linked to Facilities and/or Special Locations records. Saving the image
files to Site Plans offers some significant benefits:

1. The image may be viewed without need of internet access

2. CAMEOfm Site Plans will accept smaller image file formats (i.e.,
jpg, .gif, .tif.)

3. The TerraServer image files may be altered and edited to
display additional information; such as worst-case ALOHA
footprints, initial isolation areas, entrance and egress areas,
population counts of surrounding neighborhoods...the list of
information you may wish to add to the aerial photo is endless!

Saving an aerial view of a facility to CAMEOfm Site Plans, and
adding your own preplanning data to that photo, can be an
extremely useful tool for HazMat responders and planners!
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IndexIndexIndexIndexIndex

SymbolsSymbolsSymbolsSymbolsSymbols
.bmp  64, 66, 141, 142, 167, 168, 186
.csv  127, 152, 158, 159, 163
.gif  66, 68, 141, 167, 186, 188
.jpg  66, 68, 141, 167, 186
.mer  128, 152, 154, 158, 159, 163, 165, 166
.mie  128, 148, 172
.txt  128, 129, 131, 132, 133, 144, 147, 155, 159, 172

AAAAA
A.R.C.H.I.E.  121
Acronyms  29
Address range  45
Addresses  45
Advanced Search  27, 151
Aerial Photo  62, 63, 64, 65, 141, 182, 183, 186, 188
ArcView  98, 123, 148, 149, 180

BBBBB
Basic Search  26, 27, 28, 151
Bitmap  64, 66, 67, 68, 166, 186
BLEVE  95
Building Type  77

CCCCC
CAMEO Website  41, 79, 98
Census  21, 23, 41, 60, 105, 106, 108, 110, 116, 123, 177
Chemical ID  32, 37
Chemical Library

25, 26, 28, 29, 30, 32, 33, 37, 78, 79, 87, 112, 127
Chemicals in Inventory  35, 135
Circle Tool  51, 52
Color  51, 53, 54, 123, 144
Components  35
Conc/Dose  90, 91
Concentration  169
Concentration Graph  89, 90, 91
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Containment area  83, 85
Continuous  82
Copy and paste  37, 101, 122, 133, 141, 142, 159, 165, 167, 169, 171
County map  41, 42, 116
Create layer  142, 143, 186
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Data Backup  173
Data Recovery  173
Deleting Objects  55
Display Menu  86, 98, 116
Dose  169
Dose Graph  89, 100, 115
Draw Tool  47, 50, 51, 97, 143, 168
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Entry View  48
Evaporation Calculator  21, 78
Explosion Zone  95
Export  21, 123, 125, 126, 127, 128, 129, 130, 132, 135, 138, 139,

144, 152, 155, 158, 159, 160, 163, 165, 171, 172, 173, 175
Export All CAMEO Data  125, 166, 171, 173
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Facility Record  34, 35, 36, 142
FileMaker  121, 123, 135, 136, 151, 173, 174, 175, 176
Filemaker Find  135, 136, 151
FileMaker Pro  25
Fill Pattern  51, 53, 54
Find New Map  41, 42
Fire Hazards  30
Firefighting  31
First Aid  31
Focus Point  47, 69
Footprint

86, 88, 89, 90, 91, 94, 96, 97, 98, 100, 101, 113, 114, 115, 116, 123,
168, 169, 180, 181, 188
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General Description  27, 30, 31, 32, 122
GENERATE  128, 172
Global Hide  49
Glossary  29, 30
GNIS  60, 62, 65, 123, 177, 182
Go To Map  41, 42, 113
Go To View  48
Graphics Override  55, 117
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Health Effects  31
Health Hazards  30
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Ignition Area  94
Import  21, 123, 125, 135, 139, 140, 147, 149, 154, 155,

160, 164, 165, 171, 172
Insert Picture  64, 67, 142, 143, 186, 187
Installer  21
Instantaneous  97
Internet  21, 23, 62, 123, 180, 182, 188
Intersections  45
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Lat/Long  43, 70, 77, 140, 149, 179, 187
Layer List  47, 49, 50, 53, 54, 65, 97, 116, 117, 143
LEL  27, 94
Level of Concern  86, 87, 168, 181
Link Object  141, 156
Link this record  141, 156
List  54, 65
List menu  41, 42, 44, 47, 49, 50, 53, 54, 97, 117, 141, 142
LOC  86, 87, 88, 94, 96, 97, 150
Location  35, 52, 55, 63, 66, 77, 84, 85, 96, 101, 114, 126,

135, 143, 149, 168
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Mail Merge  166
Mailing List  166
Make Report  33, 37, 165
Map Data  43, 151
Map List  41, 42, 116
MapData.CAM  156, 157, 158
MAPInfo  98, 123
Microsoft  121, 123, 125, 127, 128, 129
Microsoft Excel

121, 125, 127, 130, 131, 132, 133, 140, 144, 145, 149, 152, 153, 154, 155, 158, 159, 163, 165, 166
Microsoft Word  37, 101, 125, 165, 166, 169
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Navigator  25, 26, 34, 35, 36, 158, 162
Network  23
NFPA  30, 32
Non-Fire Response  31
Notes  36, 135
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Object Color  53
Object Settings  50, 51, 52, 53, 55, 65, 67, 117, 141, 143, 155, 187
Open layer  142, 186
Orthophoto  63, 183
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Physical State and Quantity  35
Planning Mode  100, 101, 169
PlotALOHA  98
Pointer Tool  46,  52, 58, 90, 91, 96, 113
Polygon Tool  51, 97, 168
Polyline Tool  51
Population Estimate  105, 106, 107, 108, 109, 110, 116
Print  37, 68, 100, 139, 166, 168, 169
Properties  27, 30, 31, 94, 149, 177
Protective Clothing  31
Puddle source  83
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Quick Search  54, 58, 72, 110
Quick Zoom  46
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Reactive Hazards  30
Reactivity Worksheet  32, 33
Rectangle Tool  51, 52
Reference View  48
Relational Database  121, 123
Release Duration  85, 92, 93
Release Rate  82, 93, 96
Response Mode  100, 101, 169
RIDS  27, 29, 30, 32, 33, 36, 37, 78, 93, 94, 122
RMP-COMP  21, 22, 95, 121
Road segment  44, 45
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SAM Station  79, 80, 100
Save Current View  48
Search  28, 34, 38, 44, 72, 110, 123, 136, 151, 152, 155, 171, 172
“Search” menu  26, 28, 34, 106, 108, 110
Search parameters  27, 106, 108, 110
Segment Settings  45
Set Scale  46, 70
Set to Default Settings  49
Sharing

38, 43, 62, 65, 78, 90, 91, 96, 105, 107, 109, 110, 111, 112, 113, 116, 141, 156, 157, 171, 172
SHIFT-click  54, 110, 155
Show All On Map  38, 62, 107, 108, 110, 155, 172
Show On Map  38, 43, 45, 156, 157
Simple Point  128, 129, 132, 133, 144, 149, 155, 159, 172
Site Data  77, 114, 149
Site Plans  36, 66, 67, 141, 142, 160, 161, 162, 168, 171, 188
SitePlanLink.CAM  162, 163
Source Menu  81
Source Strength  82, 89, 92, 93, 100, 169
Splash screen  23, 25, 41
Spreadsheet  121, 122, 123, 125, 127, 129, 140, 149, 158, 179
Symbol Tool  50
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Tank Source  84
TerraServer  62, 182, 183, 184, 186, 188
Text Summary  82, 92, 93, 100, 101, 114, 169
Tier 2 Submit  21, 135, 136, 137, 138, 140, 151
Tile Windows  100, 116
Topographic  62, 63, 182, 184, 186
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UEL  27, 94
User’s Map  47, 48, 50, 51, 97, 143, 144
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View Menu  48, 70, 71
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Weather  79, 80, 101, 113
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Zoom In  46, 52, 63, 70, 71, 73
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